How to use your iPad as a Touch Bar for your Mac

Add a Touch Bar to any Mac!

Apple secrets revealed!

All-new tips for Safari, Mail, Photos, iMovie and more

NEW! Macs for 2017 Uncovered! This year’s hottest Apple kit

Speed up an old Mac

Remove Malware with ease

Add a Touch Bar to any Mac!

How to use your iPad as a Touch Bar for your Mac

REVIEWED

Go Pro Hero5 back in black

Film your adventures

Wacom Intuos 3D

Love your pen

The UK’s best-selling Apple mag!

Issue 311 April 2017

macformat.com @macformat
SYNOLOGY ROUTER
RT1900ac
Smart WiFi for your home

DS216play | DS716+II | DS216+II

4K TRANSCODING & STORAGE SOLUTION

4K VIDEO TRANSCODING
Transcode 4K videos to make them suitable for all screens and bandwidths whether they are local media players or remote mobile devices.

TURN YOUR NAS INTO A MEDIA CENTRE
Access and share all the multimedia files stored on your Synology NAS anytime, anywhere for home or work through our large range of apps.

STORE AND STREAM YOUR MEDIA
Stream digital content with Roku, Apple TV, Chromecast, Samsung TV and all Bluetooth, Airplay and DLNA devices effortlessly.

For where to buy visit www.synology.com

Available mobile Apps
iOS, Android, Windows

Synology's Media Accolades
PCR, PCPro

Social media icons: Facebook, Twitter, YouTube
The iPhone 7 Plus has an incredible dual camera that we absolutely love, but for American company Kamerar it could be even better – so it’s unveiled a dual-lens camera kit for the iPhone 7 Plus. The Zoom Lens Kit comes with an iPhone case fitted with a slim lens holder, letting you insert different lenses depending on your needs. There’s a macro lens insert and a combination fisheye/telephoto lens, so you can get up close and personal or shoot from afar, and easily switch between the two styles.

$45 (about £36) includes iPhone 7 Plus case, macro and fisheye/telephoto lens inserts

Kamerar Zoom Lens Kit

Make the iPhone 7 Plus camera even better

The iPhone 7 Plus has an incredible dual camera that we absolutely love, but for American company Kamerar it could be even better – so it’s unveiled a dual-lens camera kit for the iPhone 7 Plus. The Zoom Lens Kit comes with an iPhone case fitted with a slim lens holder, letting you insert different lenses depending on your needs. There’s a macro lens insert and a combination fisheye/telephoto lens, so you can get up close and personal or shoot from afar, and easily switch between the two styles.

$45 (about £36) INCLUDES iPhone 7 Plus case, macro and fisheye/telephoto lens inserts

WEBSITE kamerar.com WORKS WITH iPhone 7 Plus
MORE MEMORY FOR YOUR MOBILE DEVICES

Buy now from:
amazon.co.uk
Carphone Warehouse

Got a new smartphone or tablet this festive season? Don't forget to make space for more photos, videos, music, and more! SanDisk® Mobile Storage Solutions add up to 200GB¹ space to iPad, iPhone and Android™ devices.

SanDisk®
Mobile Storage Solutions
First of all, don’t worry, you haven’t fallen into a hole in space and time and travelled back to 2004. For those of you who don’t know me, let me introduce myself – I edited MacFormat for 9 years from 2004 to 2013, and now I’m back! Since I left the good ship MacFormat, I’ve been floating around in the world of technology magazines, launching new products and generally having a blast.

Firstly, I’d like to say what an honour it is to come back to the mag in which I first honed my editing skills, and to find it in such rude health. MacFormat has just posted a new circulation figure which has gone up 2.5% – in fact, it’s the title’s second year of growth! For a magazine these days, that’s an outstanding achievement. While I’d happily take all the credit for myself, I think it’s only fair to give it to your editor for the last few years, Christian Hall, and before him Christopher Phin. Also, thanks to Simon Kirrane for holding the fort for the last couple of issues while we sorted out my return. You did a great job, guys!

So, I’d like to assure you that you’re in safe hands. I’m looking forward to getting stuck into MacFormat, and taking the mag on to its next circulation rise. Enjoy the issue.

GRAHAM BARLOW
EDITOR-IN-CHIEF
editor@macformat.com

Alan Stonebridge
Production Editor
After writing his tutorial on the Bedtime feature in iOS 10, Alan is looking forward to getting some quality shut-eye, now deadline is finally over.

Alex Blake
Commissioning Editor
Alex found an unwanted copy of The Sims 4 lying around the office, right after he’d bought one for his girlfriend. he moaned for three days solid.

Paul Blachford
Art Editor
Paul’s spent this issue locked away designing the space effects on the cover. In fact, he likes the view so much he’s thinking about reserving a plot on Mars once we colonise the stars.
APPLE CORE

8  RUMOUR & NEWS
  The core Apple news you need to know about

11  APPS & GAMES
  Our top picks of the month for Mac and iOS

12  APPLE FACTS
  Amazing stats from the world of Apple

14  MACFORMAT INVESTIGATES
  Are Macs becoming more prone to malware?

16  OPINION
  Matt Bolton on the future of cloud services

18  SPLIT VIEW
  The team’s views on the latest Apple tech

APPLE HOME

21  APPLE HOME
  Build the smart home of the future today

22  SMART SECURITY CAMERAS
  Protect your valuables with clever technology

26  FRIEND OR FOE?
  Teach your security camera who’s who

APPLE GEAR for 2017

All the new kit to expect this year
APPLE CHOICE

New kit and apps – we’ve got all the latest hardware and software reviews

STAY SAFE ON PUBLIC WI-FI
Set up a secure connection wherever you are

BOOST PHOTOS EDIT TOOLS
Add Affinity Photo controls to Photos

BLOCK NUISANCE CALLS
Stop annoying telemarketers from cold calling

REMOVE ANY MALWARE EASE
Control which apps can access your data

GET A GOOD NIGHT’S REST
Improve your routine with iOS 10’s Bedtime

PROJECT: HOW TO SPEED UP AN OLD MAC
Install the Elementary OS and give your old Mac a new lease of life

WIN an Apple TV and a copy of Infuse Pro

Prizes worth £586

APPLE SKILLS

Apple Choice
New kit and apps – we’ve got all the latest hardware and software reviews

Genius Tips
Howard Oakley solves your Mac and iOS issues

Mac Hardware
Don’t let desktop kit get the better of you

Mac Software
Ease your app-fuelled anxieties with our fixes

iOS Software
Swipe away your touchscreen troubles

Win an Apple TV and a copy of Infuse Pro

Prizes worth £586

Regulars

Back Issues
Head here if you’ve missed an issue

Next Month
What’s coming in MF312 on 11 April

Photo Stream
Send us your Apple-related shots

Letters
Have your say on all things Apple-related

Subscribe Today

Issue 311 Contents

Genius Tips
Howard Oakley solves your Mac and iOS issues

Stay Safe on Public Wi-Fi
Set up a secure connection wherever you are

Boost Photos Edit Tools
Add Affinity Photo controls to Photos

Block Nuisance Calls
Stop annoying telemarketers from cold calling

Remove Any Malware Ease
Control which apps can access your data

Get a Good Night’s Rest
Improve your routine with iOS 10’s Bedtime

Project: How to Speed Up an Old Mac
Install the Elementary OS and give your old Mac a new lease of life

Win an Apple TV and a copy of Infuse Pro

Prizes worth £586

Regulars

Back Issues
Head here if you’ve missed an issue

Next Month
What’s coming in MF312 on 11 April

Photo Stream
Send us your Apple-related shots

Letters
Have your say on all things Apple-related

Subscribe Today

Issue 311 Contents

Genius Tips
Howard Oakley solves your Mac and iOS issues

Stay Safe on Public Wi-Fi
Set up a secure connection wherever you are

Boost Photos Edit Tools
Add Affinity Photo controls to Photos

Block Nuisance Calls
Stop annoying telemarketers from cold calling

Remove Any Malware Ease
Control which apps can access your data

Get a Good Night’s Rest
Improve your routine with iOS 10’s Bedtime

Project: How to Speed Up an Old Mac
Install the Elementary OS and give your old Mac a new lease of life

Win an Apple TV and a copy of Infuse Pro

Prizes worth £586

Regulars

Back Issues
Head here if you’ve missed an issue

Next Month
What’s coming in MF312 on 11 April

Photo Stream
Send us your Apple-related shots

Letters
Have your say on all things Apple-related

Subscribe Today

Issue 311 Contents

Genius Tips
Howard Oakley solves your Mac and iOS issues

Stay Safe on Public Wi-Fi
Set up a secure connection wherever you are

Boost Photos Edit Tools
Add Affinity Photo controls to Photos

Block Nuisance Calls
Stop annoying telemarketers from cold calling

Remove Any Malware Ease
Control which apps can access your data

Get a Good Night’s Rest
Improve your routine with iOS 10’s Bedtime

Project: How to Speed Up an Old Mac
Install the Elementary OS and give your old Mac a new lease of life

Win an Apple TV and a copy of Infuse Pro

Prizes worth £586

Regulars

Back Issues
Head here if you’ve missed an issue

Next Month
What’s coming in MF312 on 11 April

Photo Stream
Send us your Apple-related shots

Letters
Have your say on all things Apple-related

Subscribe Today

Issue 311 Contents

Genius Tips
Howard Oakley solves your Mac and iOS issues

Stay Safe on Public Wi-Fi
Set up a secure connection wherever you are

Boost Photos Edit Tools
Add Affinity Photo controls to Photos

Block Nuisance Calls
Stop annoying telemarketers from cold calling

Remove Any Malware Ease
Control which apps can access your data

Get a Good Night’s Rest
Improve your routine with iOS 10’s Bedtime

Project: How to Speed Up an Old Mac
Install the Elementary OS and give your old Mac a new lease of life

Win an Apple TV and a copy of Infuse Pro

Prizes worth £586

Regulars

Back Issues
Head here if you’ve missed an issue

Next Month
What’s coming in MF312 on 11 April

Photo Stream
Send us your Apple-related shots

Letters
Have your say on all things Apple-related
Whatever the next iPhone is called, be it iPhone 8, iPhone 7S or even the hotly tipped iPhone X – the X denoting the 10th anniversary of the launch of the first iPhone, one thing is looking more and more likely – it won’t be cheap. A report by Fast Company, citing a “source with knowledge of Apple’s plans”, suggests that the next iPhone will be well north of $1,000 thanks to a new OLED display that will go edge to edge, and extra memory, which will be more expensive because of a strong dollar. And that’s without counting on any additional tech that Apple packs into the device. OLED screens are more flexible and lighter than the LCD system currently used in iPhones, meaning we could see other interesting design innovations.

We’re hoping that the previous iPhone 6SE will get a hefty price drop at the same time, otherwise many are going to be priced out of the Apple’s iOS ecosystem.

Alex says...

We’re used to iPhones costing a fair whack, but this will test all but the most outlandish budget.
FASTER MACBOOKS

Stories are circulating about an even faster MacBook sporting those Kaby Lake processors and an option of up to 16GB of RAM.

KABY LAKE iMACS

New iMacs with Kaby Lake processors are rumoured to be arriving shortly. USB-C ports are also rumoured for these models.

iPad Pro

A new 10.5-inch iPad Pro with near bezel-free design is rumoured. We’d love to see this, but worry that current iPad Pro owners will feel instantly out of date.

3
4
BETTER COLOURS

The flexible, plastic, OLED display will draw less power and mean that the iPhone can be even thinner than before, all the while with a better display and higher contrast ratio.

RUMOUR MILL

Hot on the heels of the tech giant’s latest moves…

Wireless charging
36%
Improved battery life
31%
Edge-to-edge OLED display
23%
Headphone jack
10%

THE POLL

WE ASKED... What feature would you most like to see in the next iPhone?

Log on and see next issue’s big question! twitter.com/macformat facebook.com/macformat

3
6
OLED DISPLAY

The rumoured OLED display would be edge-to-edge, producing one of the most stunning iPhone designs you’ve ever seen. Rumours suggest the screen will be 5.5-inches, like the iPhone 6 Plus.

Find out more about iPhone X on p82
Apple is famously profitable, but even this is impressive. In the fourth quarter of 2016, Apple took a whopping 92% of global smartphone profits.

The number is even more impressive when you consider that it only accounted for 18% of smartphone sales, according to investment banking company Canaccord Genuity.

In contrast, Samsung took 9% of smartphone profits in the same period, while Sony took less than 1%. The figures add up to more than 100% because other smartphone companies lost money. These include LG and Microsoft, according to Canaccord Genuity.

Michael Walkley, an analyst from the firm, said that Apple benefitted from strong sales of the iPhone 7 Plus, as well as Samsung’s recall of its Galaxy Note 7 phone.

Samsung phones sold for an average price of $82 in Q4 2016. In contrast, the average iPhone sold for $695, aiding Apple’s profitability, despite selling a similar number of smartphones (77.5 million and 78.3 million respectively).
Reverb Free
Get Amazon’s Alexa voice assistant on your Mac and iPhone

If you’re tired of Siri and want to try something new, Reverb might be an option. It’s a free app that integrates Amazon’s Alexa voice assistant into both your Mac and iOS device, and won’t cost you a penny.

You can use it to manage your alarms and timers, get traffic and weather reports, call contacts and more. It works with smart home devices from firms like Philips and Samsung, so you can control your lights, thermostats and other devices from your Mac or iPhone.

If you have an Alexa device then it’s even more useful, as it means you don’t have to buy any Amazon Echo Dots to extend Alexa’s coverage. The only drawback is that it can’t play tunes from an Amazon Music account due to restrictions from Amazon. It’s not quite Siri, but if you’re into smart home tech or already have an Amazon Alexa, give it a try.

A Normal Lost Phone £2.99
A Normal Lost Phone places you in possession of a phone belonging to someone else. By exploring its contents you investigate the owner, and why they mysteriously disappeared. An immersive game that explores ideas of privacy and personhood.

Why you need it: A puzzler full of great writing.
What’s it best for: Bridging reality and entertainment.

Putty 3D £4.99
Make weird and wonderful creations on iOS with Putty 3D. This 3D sculpting app supports the Apple Pencil and a wide colour gamut too, so editing on the go will be easy and look great too. You can also export to Mac if you want to finish your work at home.

Why you need it: It’s a quick way to get creative.
What’s it best for: Making monsters on the go.

Mental Illness (Aimee Mann) £7.99
For this album, Mann set herself the challenge of matching public perception by making “the saddest, slowest, most acoustic” album - quite a promise given her last big downer, on 1999’s Magnolia soundtrack, turned out to be a career highlight.

Why you need it: Lyrics that cut through life’s nonsense.
What’s it best for: Mann’s understated and wry delivery.

Hell or High Water £9.99
Two brothers try to rob a bank in order to save their ranch, with only a grizzled sheriff to stop them. Oscar nominated neo-Western thriller.

The Infinite Monkey Cage FREE
Brian Cox and Robin Ince share irreverent thoughts on science, blending serious talk with comedic wit.

The People v. O.J. Simpson NETFLIX
The infamous murder trial gets the small screen treatment in this highly acclaimed – and highly charged – drama.
Apple’s employees in numbers

Apple employs millions of people around the world, but what do they do? We dig into the numbers to find some of the more unusual facts.

1. The total number of full time Apple employees – about the population of Bruges in Belgium. 116,000

2. Out of over 77,000 workers Apple employs in the US, only 85 (just 0.11%) are craft workers – many of whom are likely working on Apple Campus II.

3. With fewer than 50 employees, Denmark has one of the fewest counts of Apple workers in Europe. The UK, in contrast, has 6,500.

4. ~45

5. The Cork facility houses a full 25% of Apple’s European workers. 25%

6. Apple has drawn criticism over its Irish tax practices, but its Cork facility houses a full 25% of Apple’s European workers. 10,000

Next issue

We know all about Steve Jobs, but what about Apple’s other CEOs?
JetDrive™ Go 300  
FREE UP Your Storage  
Designed for iPhone®, iPad®, and iPod®

- Lightning & USB Dual Connector
- Sturdy Metallic Body
- Ultra Speed Transferring
- Photo & Video Backup
- File Manager

Dual connectors with up to 128GB extra capacity  
Extended Lightning connector design for easy plug-in  
Easy file transfer with JetDrive Go App

NOW AVAILABLE AT amazon.co.uk®
Do you need antivirus?

Should you take steps to protect your computer from malware, or are Macs still inherently safe?  

LETTERS 

ast year something happened that sent tech writers reeling the world over. No, Steve Jobs hadn’t returned from the dead; people had found the first Mac ransomware. Every Mac user is familiar with the adage that ‘Macs don’t get malware’, but is that still true? Do you need anti-malware apps for your Mac?

Naturally immune

Traditionally, there have always been two main reasons why Mac antivirus software has been seen as superfluous: macOS’ low market share, and its UNIX base.

Windows enjoys an operating system market share of almost 90%. That makes it a highly attractive target to malware authors: the larger the market share, the greater the chance you’ll find someone to exploit. And unlike Windows (based on MS-DOS), Macs are UNIX-based, which makes them much more complicated to hack. For instance, an app’s executable code and its data are stored in separate, predictable folders on a Mac. On Windows, installed programs could have files placed in a wide variety of different places, so uninstalling every lingering piece of code can be tricky – and potentially dangerous if that app can cause harm to your computer.

Malware could be installed on your Mac, but would be unable to spread to the heart of the machine. Of course, you don’t need to attack the core of a Mac to cause damage.

One could simply run a keylogger that steals sensitive data, or run a Trojan embedded in compromised text documents. Still, macOS has built-in security walls like XProtect. Opening a .dmg file that Apple thinks is suspicious will prompt a dialog box warning you that it “will damage your computer”, and you will be advised to move the file to the Trash. XProtect only checks files against a list of malicious apps defined by Apple (so it features no file heuristics), and it can’t clean up infections, but it’s still a good precaution.

Malware could be installed on your Mac, but would be unable to spread to the heart of the machine. Of course, you don’t need to attack the core of a Mac to cause damage.

Genius Tips guru Howard Oakley has a
different take on the issue. “Anti-malware software is essential for those who browse the more dodgy parts of the internet, or for many Facebook users given the frequency of its spreading bad links, or for those who have to deal with files sent to them,” he argues.

Mac maladies
Still, he says that it’s not totally necessary for everyone – common sense is key. “The single most important thing is awareness and vigilance, Howard says. “It’s like driving: you don’t take your eyes off the road or you know that something will happen. You have to watch every email, every link, always conscious of the risks.”

That’s the case with a lot of Mac malware. In 2016, security firm Malwarebytes noted a new ‘social engineering’ malware specifically targeted at Macs. Simply visiting the infected website would either cause Mail to create a vast number of draft messages, or would open iTunes multiple times (depending on your macOS version). This would cause the system’s memory to overload and the Mac to freeze. Regardless of whether Mail or iTunes is launched, the website displayed a message claiming a virus had been detected and that the user should call a (fake) Apple support number shown on the page. Presumably, this charged you for fake advice, or pointed you to more malware, as similar attacks have done. This was patched in macOS 10.12.2, emphasising why updating your Mac is always a good idea.

Paul Ducklin, senior technologist at security company Sophos, told us that virtualisation apps carry risks too. “Why risk having Windows malware lying around undetected on your Mac where you could pass it on?” he asks. For him, it’s a case of better safe than sorry.

Ultimately, the main risk to you is human error. The idea that, as a Mac user, you don’t need malware protection could be the very thing that makes you vulnerable. Being sensible on the web, checking your app installations for unwanted adware, and not opening Mail attachments from strangers – plus making sure that Gatekeeper is carefully scrutinising your Mac apps – should keep you safe. Use your common sense and, hopefully, you’ll never need the services of an anti-malware app.

Use your common sense and you’ll never need an anti-malware app

Various anti-malware apps are available for Mac, offering similar features to Windows counterparts.
Apple products have always been about improving the experience. Even the Apple I, with its homebrew origins, was unusually user-friendly by being a complete box that needed just a keyboard and display, and available in a built form. The exact nature of the experience changes over time - from the addition of a GUI in the Macintosh to the “digital hub” of the iMac and iLife combination, and beyond - but the core is always making things friendlier, and reducing friction.

Right now, the core of the experience is shifting again to the cloud. You’re probably thinking that I’m an idiot, and that iCloud is already at the centre of things, but I’d say you’re only half right. I think we’ve barely begun to see how the cloud will be the lifeblood of tech experiences in the future.

Right now, it’s just a storage service for the most part. It stores data from your phone to back it up, and stores your settings and documents to push them out to your devices. It makes your devices feel personal by giving them your data, but it does little itself. It has all this information in it, but nothing to do with it. That will change.

Consider Siri. This is actually one area where the cloud is not so dumb: Siri’s processing and responses happen in the cloud. Except that it’s still reliant on information stored on your device to give personal responses, despite a lot of that information also existing in the cloud, where you’d think Siri should have access to it. When it performs a task for you, using iMessage or other services, it does that through your iPhone or Mac, too. Despite requiring the internet, it’s an awfully offline-focused system.

In the future, Apple will surely be aiming to remove the device and offline storage from the equation. Siri will be able to access your information that’s stored on Apple servers, and run processes through apps that are part of its repertoire, not your iPhone’s (much like how Apple’s iCloud teams are reportedly being brought together to work in Apple’s old Infinite Loop HQ, but should they be out among the software teams?)

Amazon’s Alexa assistant in its Echo devices works with third-party services). This will divorce Siri from its hardware constrictions, which blows open the possibilities. In just a couple of years, you could have AirPods paired to an Apple Watch that includes a 5G internet connection. Ask Siri anything about your personal information, or to perform tasks, and it will be able. No iPhone required. One day, even the Watch part may become unnecessary.

This is just one aspect of the cloud-first world. It will also become even more central to more traditional elements, such as Mac apps. But for Apple to truly take advantage of it, it needs to reflect this in its structure. iCloud specialists can’t be their own group, divided off - they need to be working at the heart of every software team Apple has. The cloud is no longer a feature to be added to an experience: it’s the foundation.

ABOUT MATT BOLTON
Matt is the editor of Future’s flagship technology magazine T3 and has been charting changes at Apple since his student days. He’s sceptical of tech industry hyperbole, but still gets warm and fuzzy on hearing “one more thing”.

The cloud stores info, but does nothing with it. That will change
I want to be unhackable.

That's why I want a solution that protects me from online threats and keeps me worry-free.

Get protected now at Kaspersky.co.uk

KASPERSKY
THE POWER OF PROTECTION

© 2017 Kaspersky Lab. All rights reserved. Registered trademarks and service marks are the property of their respective owners.
The MacFormat team debates the hot Apple issues of the day, using their iPhones of course!

**“WHAT’S THE BEST APPLE PRODUCT YOU’VE BOUGHT?”**

**Alex says...**

It has to be my iPhone 6 Plus. I was reluctant about getting such a large phone at first, but the bigger screen is fantastic for watching videos and reading articles.

**Graham says...**

I’m still on an iPhone 5s! Now I’m back on MacFormat. I’m looking forward to expanding my Apple armoury - I’ve already got my hands on the new MacBook.

**Jimmie Iovine**

apple.com

“Apple... was the one that understood why artists make things.”

Apple Music impressario explains how Apple has merged tech and music.

**David Sparks**

macsparky.com

“Apple should add features to iOS that allow users to be more productive.”

Noted Apple blogger feels Apple needs to do more to help boost iPad sales.

**Ken Segall**

kensegall.com

“He did not force us to follow a rigid process, even after we went into production.”

Former Apple ad guru says Steve Jobs’ management style was key to success.

**Tim Cook**

apple.com

“Apple would not exist without immigration, let alone thrive and innovate the way we do.”

Apple chief opposes Trump’s immigration policies in letter to staff.

“I suspect the iPhone 8 (or iPhone ‘X’) is going to be the best Apple product I’ve ever bought. We’ve just got to wait to see if Apple deliver the sort of product we’ve been speculating about this issue.”

---

*Subscribe Today! Save 54%!*

Turn to page 46

---

**Siri...ously?**

You still haven't returned the lawnmower I lent you.
BE THE DJ

DJ STARTER PACK INCLUDES

DDJ-WEGO4 CONTROLLER
Mix your music & add effects
Multiple DJ Software Compatibility*
rekordbox DJ for PC or Mac included

DM-40 SPEAKERS
Compact Desktop speakers with a rich, balanced sound for DJs & producers
Soft dome tweeters with convex diffusers for a 3D stereo sound

HDJ-700 HEADPHONES
Monitor headphones optimised for dance music
Rotatable right earpiece with rubber grip

*rekordbox DJ licence key included. Also compatible with WeDJ & djay 2 for iOS & Virtual DJ 8 Limited Edition, all sold separately. Compatible with iPad, iPad mini & iPhone not included.
Watching your favourite shows on Apple TV is about to get a lot easier. That’s because we’re giving away three 32GB Apple TVs and a whole heap of Infuse Pro 5 licences from Firecore!

The app works across Apple TV, iPhone and iPad. When compared to the default way of watching your TV library on Apple TV or iOS, Infuse Pro is simply leagues ahead. It’s a visual treat, automatically displaying your folders as thumbnails or cover art, letting you sit back and enjoy your favourites in style.

You can sync videos from cloud services like Dropbox or your iTunes library, or start watching on one of your devices and pick up where you left off on another. It’s compatible with AirPlay, highlights in-progress items on Apple TV and works with Split View and Picture-in-Picture on iOS. And it’ll even find the appropriate subtitles if your shows are missing them. All that with simple gesture controls and drag-and-drop file transfers.

Three lucky readers will win a 32GB Apple TV and an Infuse Pro licence, while 10 runners up will each win an Infuse Pro licence. It’s a great way to upgrade your living room for free!

THE QUESTION
For a chance to win an Infuse Pro 5 licence and an Apple TV, simply answer this question:

What Apple streaming service does Infuse Pro 5 work with?
A) AirPlay
B) ApplePlay
C) AirPods

For more information about Firecore’s Infuse Pro app and its full range of other products, direct your web browser to firecore.com.

Win a copy of Infuse Pro and a chance to take home a new Apple TV.

Win an Apple TV & Infuse Pro!

Overhaul your living room with a better TV experience from Firecore!
What's inside

22–25
SMART HOME SECURITY CAMS
› Keep a watchful eye on your property with a clever security system

26–27
TUTORIAL
› How to set up face recognition to tell apart family from strangers

Contact us
› Email your queries and your questions to letters@macformat.com
› Keep up to date by following us on Twitter @macformat
› Join the conversation at facebook.com/macformat
› Get the latest subscription offers at macformat.com

Editor's note

Arely a year after we last looked at security in Apple Home, it's undoubtedly the smart home category that's seen the greatest growth in recent months. That's hardly surprising, though; smart fridges and voice-controlled lighting are fun to play with if you've got a bit of spare cash, yet security is an important daily concern for everyone.

The star of the show in the last year or so has undoubtedly been the humble security camera. In fact, one recent survey estimated that security cameras on their own now account for more than 60% of all the money spent on smart home products in the US. This issue we focus on the latest security cameras and the advances in technology that can help to keep your smart home safe.

You can see who is moving around your home on your Mac, iPhone, iPad, and even Apple Watch.

APPLE HOME
EDITED BY CLIFF JOSEPH

Security cameras are the key product that brings smart tech into many homes, and they're getting more intelligent all the time.
Get started with Security Cameras

A security camera is many people’s first smart home device, and new models have increasingly sophisticated technology.

What about HomeKit?

Initially, HomeKit didn’t work with cameras, but that changed with iOS 10, and you can control them with the Home app provided with it. When new HomeKit-compatible models from the likes of Withings and D-Link arrive, you’ll be able to link them to other HomeKit accessories, perhaps telling the camera to turn on the lights so that it can get a good picture of a nighttime intruder.

Wired or wireless?

Most smart security cameras conveniently make use of your Wi-Fi network, enabling you to move them around. If a room has poor reception, fortunately Netatmo, Netgear, Withings and D-Link make cameras that use an Ethernet cable.

here’s no doubt that we see more information about security cameras than any other type of smart home product. In fact, browsing the website of one high street electronics store recently revealed no less than 68 different cameras, with the majority falling into the £100 to £200 price range.

Having such a wide range of products can make it difficult to choose one. Whichever you pick there are a number of key features and technologies that it’s worth considering when you buy your first security camera.

Look sharp

Top of the list for any camera, of course, is image quality. We’ve all seen news reports on TV with video footage that’s so blurry you end up wondering why they bothered spending any money on a CCTV system in the first place. Most manufacturers provide affordable, entry-level security cameras with 720p resolution (1280x720 pixels) for around £80, and we’d certainly recommend that as the minimum requirement for a security camera.

The first generation of smart security cameras was pretty straightforward, relying on simple motion detection to keep an eye on things while you were away from home. If the camera detected any movement while you were out, it would automatically start to record video footage and send an alert to your iPhone. However, the latest models are starting to use sophisticated artificial intelligence techniques that provide more advanced features.

Netatmo’s Welcome camera (£199, bit.ly/2kAikkQ) was one of the first to use face recognition technology to tell the difference between a burglar and your kids arriving home from school. Netatmo’s newer Presence camera (bit.ly/2l1l6A8) goes even further; it’s a bit pricey at £250 due to being weatherproof for outdoor use, and includes face recognition technology.

Netatmo, Withings and D-Link are just a few of the many companies making cameras that can identify specific sounds.
Many home security cameras support IFTTT (If This, Then That), a system which allows devices from different manufacturers to work together. Using IFTTT requires a degree of programming skill, but IFTTT's website (ifttt.com) provides prebuilt mini-apps, or applets, that will work with many devices. IFTTT for iOS is free from apple.co/2lGiBu9.
Can I use more than one camera?

The iPhone apps for most security cameras enable you to monitor a number of cameras in different rooms around your home. However, some may require additional hardware in order to control multiple cameras, such as the Base Station sold with Netgear’s Arlo cameras, or D-Link’s Connected Home Hub.

What about indoor or outdoor use?

Most security cameras are designed to be used indoors, and aren’t particularly sturdy. If you want a camera for outdoor use then you should look out for a two-digit IP rating. The first digit refers to resistance to dust and other damaging particles, while the second digit indicates water-resistance. Netgear’s Arlo Pro is rated at IP65. See bit.ly/2kQkNWX for more details.

a powerful floodlight, too. It’s designed to monitor activity outside your home or office, so Netatmo developed new software that it claims can differentiate between people, pets and passing cars. Netgear’s Arlo Pro (£275, bit.ly/2ku1Yb2), another weatherproof outdoor camera, claims to recognise trees swaying in the breeze so that it doesn’t keep sending you false alarms on a windy day.

Logitech’s indoor Circle camera (£159, bit.ly/2kcZ613) won our group test in MF299 and is to gain a ‘people recognition’ feature, so that it only reacts to human intruders rather than pets wandering into view. And, at long last, we’re looking forward to seeing Withings’ Home Plus (£170, withings.com), and an unnamed camera from D-Link, which will be the first security cameras to support Apple’s HomeKit. That will enable you to control the cameras by giving verbal commands to Siri, and to use iOS 10’s Home app to link the cameras to other devices that also work with HomeKit, such as motion sensors, lighting and doorbells.

Sound and vision

Artificial intelligence is advancing in other areas, too. Most security cameras include a microphone so they can record both sound and video, but Swann’s SoundView camera (£150, bit.ly/2kAxfeP) can listen for specific types of sound, such as breaking glass, that might warn you of a possible crime. However, the most advanced sound technology we’ve seen so far comes from Cocoon (£159, cocoon.life). It uses Subsound technology that can pick up faint sounds and vibrations from all around your home, not just in the one room where the camera is located. It can detect sounds such as creaking floorboards, and claims to be smart enough to tell the difference between your kids charging up and down the stairs and a burglar tiptoeing around at night.

There are some other weird and wonderful variations on the security camera theme. Sengled’s Snap (£180, bit.ly/2kAo0vb) sneakily hides a 1080p camera inside a power-efficient LED smart light bulb, enabling you to monitor areas such as hallways or stairs without revealing the presence of a camera. We also like the Canary camera (£160, canary.is/uk), which combines a 1080p camera with a honkingly loud siren, and even a sensor to check humidity and air quality in your home.

While security cameras are often the first smart home device that most of us buy, many cameras are also designed to be used in conjunction with other security devices, such as motion sensors and contact sensors that can be attached to doors and windows around your home. HomeKit-compatible devices of those types are already available – for example, Elgato’s Eve Door & Window and Eve Motion sensors (elgato.com/en/eve). So, you can get started today with one of the cameras that we’ve mentioned here, and we’ll come back to explore some of the other security devices that can provide extra protection for your home in a future issue.
We recommend five of the smartest security cameras for your home

Intelligence in cameras is improving so that they can, for example, alert you only to human movement, not pets

### FIVE OF THE BEST

**Cocoon** £159
[cocon.pl](http://cocon.pl)
As well as its 1080p camera and night-vision mode, this UK-based crowdfunding success uses Subsound tech to detect sound and vibrations throughout your home. As well as sending alerts to your iPhone, it has a seriously loud 90dB siren.

**Logitech Circle** £159
[logitech.com/en-gb](http://logitech.com/en-gb)
Though there are more technically advanced cameras available, we like Circle’s ease of use and semi-portable design. It’ll spend most of its time in its mains-powered dock, but its rechargeable battery means you can move it for up to 12 hours.

**Netatmo Presence** £250
[netatmo.com](http://netatmo.com)
Presence is expensive, but is also one of the best outdoor cameras you can get right now. It provides 1080p resolution with night vision, and has a floodlight to scare away intruders. You can save video to an SD card or a Dropbox account.

**Netgear Arlo Q** £170
[arlo.com/uk](http://arlo.com/uk)
This affordable 1080p camera provides two-way audio and night vision. But the best thing about Netgear’s Arlo cameras is that they enable you to store the last seven days of video footage online for free, with no need to pay a monthly sub.

**Withings Home Plus** £170
[withings.com/uk](http://withings.com/uk)
We haven’t laid our hands on the Home Plus yet, but it’s essentially an updated version of the popular Home camera that adds support for HomeKit - the first security camera to do so. You can even watch its video on your Apple Watch or Apple TV.

---

**iFacts…**

- **$47.5bn**
The estimated value of the global home security market in 2020. (RnR Market Research)
- **61%**
The amount of smart home spending in the US that’s attributable to security cameras. (NPD Connected Intelligence)
- **701,000**
The number of burglaries in the UK in the year to March 2016. (Office for National Statistics)
- **4.4%**
Baby monitors are on the rise too, forecast at 4.4% global growth every year until 2020. (Transparency Market Research)

---

> macformat.com  @macformat

APRIL 2017 | MACFORMAT | 25
Explained

NIGHT VISION

Many security cameras claim to have a night-vision mode that enables them to work in low light conditions. However, the better cameras will also include an infrared (IR) emitter that enhances visibility at night.

The latest security cameras use sophisticated artificial intelligence techniques that provide even more advanced features.

Genius Tip!

Somewhat oddly, Netatmo’s Welcome camera includes an 8GB MicroSD card, but doesn’t provide an online storage option. You can link it to a Dropbox account to store your security footage online, though.

How To  Tell visitors and strangers apart

1 Home and away

Like most security cameras, Netatmo’s Welcome can track your location through its app on your iPhone. You can link it to other family members’ phones too, so it knows when your home is empty and to keep watch.

2 Face to face

Netatmo’s Welcome was one of the first security cameras to use face recognition. As soon as you turn it on, it starts to note each new face it spots. Then you just hold a finger on a face in order to identify that person.
WHAT ELSE SHOULD I CONSIDER?

ONLINE STORAGE COSTS

You can view live video for free, but other features may cost you extra.

Unusually, Netatmo’s Welcome and Presence cameras include a MicroSD card to store video directly on the camera itself. In contrast, most manufacturers opt to use online storage instead, and this is where you need to watch out for extra hidden costs.

Netgear’s Arlo cameras enable you to store video footage online for seven days for free, which should be enough for most people. Beyond that period, it charges £6.49 per month to store your recordings for 30 days. Logitech’s Circle stores video for 24 hours for free, before charging £2.99 per month for 14 days of storage. Swann’s SoundView camera and the Sengled Snap, however, only provide you with live streaming – they provide no free online storage at all.

hen your camera detects an intruder, it sends an alert to your iPhone and streams the video image so you can see what’s going on. However, you may need to store recordings for longer, perhaps as evidence of a crime.

3 The spying game
You don’t need to worry about family members, but if there are people who only visit occasionally, you can tell the camera how to react: to record one video on arrival, or to keep an eye on them the whole time.

4 Stranger danger
If the camera spots a face it doesn’t recognise, such as this delivery driver, it will automatically record video and send an alert to your iPhone. It will also take a pic so you can add that person to the app if you want.

Jargon Buster

Power over Ethernet
Most security cameras run off batteries or mains power, but some can use PoE, or Power over Ethernet, which enables the camera to get both power and internet access from a single cable. This can be really useful if you want to install several cameras around your home or office.
Apple secrets revealed!
You would find it difficult to miss Apple’s fondness for minimalism. After all, it’s not like the iPhone is awash with ports and buttons, and if the new MacBook Pro is anything to go by, all Macs will soon be kitted out with only Thunderbolt 3 and headphone ports, making it rather tricky to plug something into the wrong bit.

In software, it’s a mite tougher to pare things down quite so much; you must strike a balance between making an app accessible and ensuring that it remains intuitive and capable. For the most part, Apple succeeds, but it does sometimes exhibit a tendency to bury important features and interesting settings in places not everyone would consider looking for them.

This feature is about all these things. We’ll explore the software you get for free with every Mac, and frequently delve into new features introduced in Sierra, as well as long-standing ones that are little-used. The idea is that in spending a short while flicking through these pages, you’ll come out the other side armed with new skills to make working with your Mac faster and more efficient.

Note that for the most part, none of our advice in this feature is especially complex. These tips neither require you to put on your ‘advanced Mac head’ cap, nor first read a weighty tome on how to use the Mac. Instead, this is about highlighting useful features, options, settings and controls that might have passed you by – but that with a flick of a virtual switch could prove transformative to how you use your Mac.
Delve deeper into Apple’s famous digital jukebox, taming its interface, tweaking its views, and then dancing around like a loon

16 tremendous iTunes tips

View the sidebar
You can browse your library with or without a sidebar; without it, views and playlists are accessed through the arrow next to Library in the navigation bar. To toggle it, choose View > Show/Hide Sidebar.

Switch media type
This menu enables you to switch between types of media, or you can press $+$ through to $9$. You can edit its contents: pick Edit Menu from it and leave check marks next to items to keep visible.

See the status bar
The Status Bar is hidden by default, but you can make it visible with View > Status Bar. It shows the current view or selection in terms of storage size taken up, duration of running time, and an item count.

Edit cover art
If album art is missing, sign in to the iTunes Store, click the album and choose Get Album Art. If that fails, pick Get Info instead, click Edit Items, and drag art from an online search into the Artwork.

Smart Playlists
If you’ve a lot of music, pick File > New > Smart Playlist. Set one rule to ‘Last played not in the last 30 days’ and then set playback to shuffle for an instant jukebox with no recently played tracks!

Use the MiniPlayer
Turn iTunes’ window into the MiniPlayer by clicking the album artwork in the status area, or press $0 + X + M$. In iTunes > Preferences > Advanced you’ll find an option to keep it on top of other windows.
How to Take control of viewing your music

1. Recently added items
   Select Recently Added in the sidebar to see music, including store purchases and Apple Music items added to your own library, in reverse chronological order. To see what you can play while offline, choose View > Only Downloaded Music.

2. The column browser
   Select Songs in the sidebar, then choose View > Column Browser > Show Column Browser (or press ⌘+B) to restore the classic interface for filtering your collection by genre, artist and then album from left to right in the window.

3. Change view options
   Choosing View > View Options often provides a number of settings to further tweak how your music is presented in the current view. For example, when using the column browser, you can turn on album art and pick the visible columns.

Tricks for a tip-top listening experience

4. Check your iOS apps’ size
   Switch to the Apps from the media selector, then click Library to the right. If you download iOS apps to your Mac, they may use lots of space. If you’re low on storage, ⌘-click an app, view it in Finder, and back up the entire folder. Then in iTunes, select the largest apps, press ⌘+∫ and pick Move to Trash.

5. Refresh the iTunes Store
   The iTunes Store will sometimes show a blank page or just stop working. When this happens, press ⌘+R to reload it – it’s essentially a web page.

6. Use File Sharing
   With an iOS device selected, pick Apps in the sidebar and scroll down to File Sharing; it lists apps that can transfer files to and from your Mac, which can be faster than using iCloud.

Consider quality

Most of us will find the 256Kbps AAC music files created by importing a CD into iTunes are good enough quality. For the greatest flexibility in future, in case more efficient compression tech arrives, consider switching from the default AAC encoder to Apple Lossless – to do so, click Import Settings in iTunes’ General prefs.

The drawback is Apple Lossless files use more space than AAC, which might quickly use up your Mac’s storage. One fix is to use File > Library > Consolidate Files to put your music on an external drive and manually clean out the originals later on. You’ll find a detailed overview of what this involves at apple.co/2lpHbsL.

> macformat.com > @macformat
16 fantastic features of Photos

Make fast work of browsing and editing your digital photo collection using Apple’s Photos app

1. **Use pinch gestures**
   You could drag the resize slider on the toolbar, but it’s much more pleasing, if your Mac has a trackpad, to pinch to zoom. Pinch gestures also open or close the image that’s under the pointer.

2. **Edit your photos**
   After opening a photo, a button with three slider controls appears in the toolbar; it takes you to editing mode; or, press `⌘` while viewing a photo or selected in an album, to go straight to editing it.

3. **Get info**
   Press `⌘ + I` to bring up the contextual Info window. With one image selected, it shows camera info and settings. For an album or a multiple selection, it summarises dates, places, keywords and more.

4. **Browse faster**
   With a photo from an album or the timeline open, swipe left or right on a trackpad or Magic Mouse to view adjacent images. To browse faster, click Show Thumbnails, put the pointer over them, then swipe.

5. **Use the sidebar**
   Photos has five large buttons across its toolbar for its major sections. Choosing View > Show Sidebar switches to an alternative means of navigating that’s more efficient if you have many albums.

6. **Choose a key photo**
   When you create a new album from several photos, the app assigns a representative thumbnail. If you’re unhappy with its choice, open the album, select an image, and choose Make Key Photo.
Find screen grabs

If you take screenshots on iOS, they’ll end up in iCloud Photo Library and on all connected devices. You can view them in the Screenshots album in Photos. Sadly, there’s no way to stop any you keep from showing up elsewhere in your library.

Select and delete

Hold ⌘ and click screenshots you no longer want to build a selection, then ⌘-click one, choose Delete and click the Delete button on the confirmation dialog. Made a mistake or changed your mind? They can be recovered within 40 days.

Save keepers

Go to the Recently Deleted album and select those images you want back, then click Recover. Or, hold ⌘ and drag them to Finder to save them outside of Photos; this copies them as PNG files, rather than compressed JPEGs.

1. Add adjustments

When editing a photo, the Adjust tool initially provides three options: Light, Color and Black & White. For more, click Add and choose one; click Save as Default in that list to use your chosen adjustments by default in future.

2. View fine details

Adjustments are first presented as a single bar that you can drag across to change the effect’s strength. Put the pointer over the adjustment and click the downwards-facing arrow that appears to reveal more settings and to access an auto button.

3. Search with smarts

We’re not quite at the point Photos can easily pinpoint a specific snap within many thousands, but the version that comes with Sierra now enables you to search for places, people, and even objects; try searching for ‘tree’ or ‘food’.

4. Reduce motion

Sierra introduced accessibility settings that reduce motion in the system and apps. They don’t affect everything they should; Photos, though, has its own item in its General preferences, which removes the jarring-to-some animation that plays when you change sections by clicking the buttons in its toolbar.

5. Save some memories

The Memories section essentially shows automatically generated albums; Photos can be inspired in what it pulls out of your library. Scroll to the bottom of a memory to add it to your favourites, which appear in the Albums section.

6. Share your photos

Select some photos, click the Share button and pick iCloud Photo Sharing. You can invite other people to subscribe to a shared album. While viewing one of your shared albums, click the toolbar’s People button to: set whether others can post; toggle notifications; and turn the album into a web page.

HOW TO Clear screenshots out of your library

Master the finer points of Photos

iCloud & Photos

It’s important to know about the differences between options found in the iCloud tab of Photos’ prefs. My Photo Stream is for accessing recent photos on devices not using iCloud Photo Library; it contains images from the last 30 days, and it costs nothing. iCloud Photo Sharing is also free, and is for sharing select images with other people. iCloud Photo Library automatically stores full-quality originals of all your photos online - keep a second backup! Your devices can be set to download the originals or versions optimised for their screen. It can quickly use up the storage in your iCloud account; to get more, click Manage in System Preferences > iCloud.
16 surfing shortcuts in Safari
Make Apple’s web browser work the way you want it to, and tame the worst tendencies of websites

1. Pin oft-used sites
You can pin tabs for sites you use often so they’re immediately accessible in any Safari window that has the tab bar visible. Either right-click and choose Pin Tab, or drag a tab to the far left of the bar.

2. Show all tabs
When you click this button you’ll get a visual overview of the tabs open in the same Safari window, and also a list of tabs open on your other devices signed into the same iCloud account.

3. The Favorites Bar
Choose View > Favorites Bar, then visit a site, click in the address bar and drag the site’s icon to the bar to pin a shortcut there. In Safari’s General prefs, new tabs can be set to show your favourites.

4. Share web pages
Click the Share button and you can add the current page to your reading list for later perusal (access it by pressing ⌘ + X + 2), add it to your bookmarks, or send it to a number of other services.

5. Quieten noisy tabs
If a tab’s playing sound, you can mute it by clicking the speaker icon in its tab, or the one in the address bar; If the latter is shown as an outline rather than solid, clicking it will mute all tabs.

6. Strip away clutter
On a page with enough body text, click the paragraph icon at the address bar’s left end to switch to Reader and see only the vital text and images. Click ‘aA’ at the bar’s other end to adjust presentation.

The best 4K Ultra HD Blu-ray movies
By Stephen Lambrechts 2 hours ago Blu-ray
Take advantage of your 4K HDR TV

4K ULTRA HD

LUCY

DRIVE

OBOLION

TOM CRUISE
HOW TO  Access mobile content on your Mac »

1. Turn on a menu
   In Safari’s Advanced preferences, turn on the Develop menu. Though it’s primarily designed for web developers, but its Open Page With submenu is useful for opening the current page in another browser if it doesn’t work well in Safari.

2. Change user agent
   Some websites bizarrely still insist on Flash for video. Others present a more cluttered desktop version than they do on mobile devices. When you find this happens, try choosing iPad under User Agent in the Develop menu.

3. Switch back
   The mobile site might look different, but should still be usable. You can change back by selecting Default from the User Agent submenu. If you use an option often, create a shortcut in the Keyboard pane of System Preferences.

Advanced tips to help you browse better »

1. Use Mission Control
   Want to quickly compare pages in Safari? You can use Split View for a two-up view, but also Mission Control. Hold ≡ and tap the Mission Control key on your keyboard to see an overview all open Safari windows.

2. Show full site addresses
   By default, Safari shows a site’s domain (such as apple.com) but not the full address of the page you’re on (say, apple.com/uk/mac). You can change this in its Advanced prefs by putting a check mark next to ‘Show full website address’.

3. Tame notifications
   Occasionally, you’ll happen across a site that will ask permission to show alerts in Notification Centre. If you accidentally grant permission, go to Notifications in Safari’s preferences and click Deny next to the site’s name.

4. Manage downloads
   In Safari’s General preferences there are options that determine download behaviours; you can alter the folder where they’re stored, tell Safari to remove items from its download list after a specific action (quitting or the download finishes, rather than after a day) and auto-open ‘safe’ files.

5. Access passwords
   If you allow Safari to save passwords for websites, they can be checked in the Passwords tab of its preferences. Enter your user account’s password (or use Touch ID) and you can click a password to temporarily reveal it.

6. Control tabs
   Choosing View > Show Tab Bar and the tab bar becomes always visible, even if a window has just one tab. In Safari’s preferences, you can refine tab behaviour further, including whether new pages and X-clicks open the page at the other end of a link in a new tabs or windows.

Get smart with searching

People tend to think of searching the web as Google, but there’s more to it in Safari than that. In Safari’s Search prefs are several search engines to choose from; DuckDuckGo is increasingly popular.

If the Include Safari Suggestions item is on, you’ll get results for basic queries in the search bar: start typing ‘weather’ and you’ll likely get a local forecast before you finish. Enter your favourite football team’s name to see its last match result.

You can even submit terms straight to a website’s search engine. To train Safari, visit a site and use its search engine; next time you start typing the site’s address, use to complete it, then add terms and press to go straight to the site’s search results.
7 Pages, Keynote & Numbers tips

The apps formerly known as iWork work well together, and are packed with plenty of great features for you to learn

1 Collaborate!
Pages, Numbers and Keynote enable working on docs with other people at the same time. Click Collaborate on the toolbar to invite people to work on your doc using the Mac, iOS or iCloud.com apps.

2 Access word count
To keep an eye on how wordy a Pages document has become, choose View > Show Word Count. Move the pointer over the counter and a pop-up indicator appears; click it to change the unit that’s used. You can drag the counter anywhere over your doc.

3 Remove a background
Add an image, click the Format button in the toolbar and click Instant Alpha. Click and drag on an area of the image to make that colour, and similar ones, transparent. The effect is applied contiguously, so similar colours elsewhere may need editing.

4 Rename text styles
It’s easy to end up with many similarly named text styles, but you can assign your own names to tell them apart. Click the style selector in the Format sidebar, move the pointer over a style’s name, click the arrow to its right and choose Rename Style.

HOW TO Copy content between iWork apps

1 Copy and paste images
It’s simple to move content between iWork apps. Try it: in Keynote, make a doc based on the Showroom template. Add a slide with a bike, select the bike and copy it to the Clipboard. In Pages, make a blank doc and paste the bike.

2 Move a chart
The apps can move about more than just images, though. In Numbers, create a new doc using the Charting Basics template. Select one of the charts, copy it to the Clipboard, and then paste it into your Pages document.

3 Edit the chart
The smart bit is that the chart isn’t a static image - you can still edit it. Click the chart and then click the Edit Chart Data control that appears next to it. A new window then appears, in which you can adjust data and add new rows.
Ensure you’re always on time and that you never forget a face with the Mac’s built-in personal organisers.

Many people stash info in Contacts that’s used elsewhere, but they don’t necessarily use the app itself very much. However, Contacts has a lot going for it. In its Template preferences, define the default information you consider important when creating a new contact. Also, when editing existing contacts, you can drag in a photo – from Facebook, say – that’ll then show up in other apps, helping to identify messages and FaceTime calls.

Use the note section in contact cards to add simple keywords, such as ‘family’. Choose File > New Smart Group and set a condition for ‘Card contains’ your keyword. That group can then be used in Mail; to aid autocompletion in Mail’s To field, prefix the group’s name with a symbol, such as $.

**View the sidebar**
Click the Calendars button to open the Calendar List sidebar. Use the checkboxes to show or hide events by calendar. There’s also a smaller calendar to help with looking up dates; drag up on the line above it to see more.

**Fine-tune Calendar**
In General prefs, weekends can be omitted from Week view by setting ‘Days per week’ to 5; if on 7, any day can be the week’s start. ‘Scroll in week view by’ sets the arrows around the Today button to advance by a week or a day.

**Speed up entering event details**
Drag over the calendar to set an event’s duration over hours or days, then enter details. Or, more quickly, click the + button and use plain English, such as ‘Lunch with Graham on Friday from 12 to 2’.

**Time to leave**
Double-click an event to edit it, then click the time and date row and set a ‘Time to Leave’ alert to be notified based on your and the event’s locations, and live transit conditions and your choices in View > Directions in the Maps app.

Do more with Contacts
Many people stash info in Contacts that’s used elsewhere, but they don’t necessarily use the app itself very much. However, Contacts has a lot going for it. In its Template preferences, define the default information you consider important when creating a new contact. Also, when editing existing contacts, you can drag in a photo – from Facebook, say – that’ll then show up in other apps, helping to identify messages and FaceTime calls.

Use the note section in contact cards to add simple keywords, such as ‘family’. Choose File > New Smart Group and set a condition for ‘Card contains’ your keyword. That group can then be used in Mail; to aid autocompletion in Mail’s To field, prefix the group’s name with a symbol, such as $.
Apple’s book-reading app isn’t just for reading – you can also use it to collect and comment on books.

## 1 Use iCloud
When first used, iBooks asks if you want to use iCloud. If you do, items you add will be synced across your devices that use the same account. To activate it later, turn on iBooks in iCloud > iCloud Drive in System Prefs on your Macs and Settings on iOS devices.

## 2 Don’t use iCloud
Yes, we know what we just said, but if you keep your books only on one Mac, you can use the app purely as a reader for eBooks and PDFs – the latter open in Preview. (If your iCloud account has plenty of free storage, you might leave iCloud on anyway.)

## 3 Sort and view more
By default, iBooks puts recent additions at the top left, which you can change in View > Sort By. Also, books are initially represented by a thumbnail image alone; View > Show Title & Author adds a book’s title or filename and author (if known) below.

## 4 Create collections
Click Collections and you may see iBooks has sorted your documents into Books and PDFs. To make a new collection, select some items, ⌘-click one, choose New Collection from Selection, and name it in the sidebar. Each item can be in one collection.

---

### HOW TO Fine-tune your iBooks experience

#### 1 Go full(ish) screen
If any app naturally suits full-screen mode, it’s iBooks. Even if you want to keep the clock visible while reading, ⌘-click the Zoom button (the green one) to make the window fill the rest of the display for a better experience.

#### 2 Change the theme
If you can’t read a book’s text comfortably, click the appearance button (AA) and adjust size, font and page and text colours. For a faster way to adjust the text size multiple times in succession, use ⌘+= or ⌘+=+.

#### 3 Take things further
Unsure about a word’s meaning? Double-click it for its definition. Want to scribble down some thoughts? Highlight a block of text then choose a colour and add a note; click the note icon near the top left of iBooks to view your notes.
5 power tools in Preview

Open a PDF? Sure. But with Preview you can do far more, from automated slideshows to scribbling all over a document.

---

1. **Sidebar speediness**
   Choose View > Show Sidebar to get a pane of page thumbnails for your document. That menu also contains options to switch to a table of contents, highlights and notes, bookmarks, or even a thumbnails-only contact sheet.

2. **Change your view**
   Preview uses a continuous scrolling view of single pages by default. If you’ve opened a comic or magazine, View > Two Pages is better suited to a wide screen. Fancy slowly reading in automated fashion? Try View > Slideshow.

3. **Add highlights**
   For basic edits to a PDF, use the Highlight button in the toolbar. Select some text, click the button’s downward arrow, and choose a colour – or use strikethrough to flag something for deletion. Save the file to keep your markings.

4. **Make major edits**
   If you’re of the opinion a PDF needs more radical alteration, you can’t directly edit it in Preview, but you can pick View > Show Markup Toolbar and use its tools to add shapes, free-form sketches, sticky notes, text boxes, and signatures.

---

**Arrange PDFs**

Being able to merge PDFs and manage pages within them used to require expensive software, but Preview can take care of these tasks pretty easily.

To delete a page, the simplest way is to use the sidebar’s Contact Sheet view, select the page, press ⌘ and then save the file.

To merge some pages from one PDF into another, open both and have their windows side by side and in Contact Sheet view. In one window, select the pages you want to move and then drag them into place in the other document’s window, then save that document. Alternatively, if you want to merge an entire PDF into another, open one, drag the second file from Finder into the Contact Sheet view, and then save.

This kind of editing can be very handy, whether it’s to quickly chop some pages from a presentation or assemble custom books, manuals or other material to read.
Find your way around the world and unearth nearby points of interest with this informative tool.
Notes and Reminders niceties

Never lose nuggets of genius on scraps of paper again – instead, store them safely in these two apps.

1. Format your notes
   Click the format menu (Aa) to give notes titles and headings. In Notes’ preferences, you can set the first line of new notes to be a title or heading. Even if you don’t format notes, be mindful the first two lines are shown in the sidebar.

2. Work with attachments
   The Share buttons in Safari and Maps can add content to specific notes as a visual preview and large button. In Notes, click the button that shows four squares to browse such attachments by category.

3. Temporary lists
   Click the checklist button (or use Option+X+L) to turn the current or selected lines into a checklist. Click, or press Option+X+U, to mark an item as done. This is great for quick lists, but it’s wise to still use Reminders for more complex ones.

4. Share notes
   Click the Share button to send the current note to the likes of Mail and Facebook. If a note is stored in iCloud, not just on your Mac (check in the sidebar), click the Add People button to invite someone else to collaborate on it.

Refresh your reminders

At its core, Reminders is an app for making checklists – a digital replacement for a short paper-based list of things you need to deal with. The app can boost productivity and efficiency in several ways. Put the pointer over an item and click the info button and you can turn the item into a time- or location-based reminder. So, if a task is time-sensitive or needs to be done when you arrive at or leave a particular place, Reminders can give you a gentle nudge on your iCloud-connected Macs, iOS devices and Apple Watch.

Lists can also be shared with people: set up a list, put the pointer over it in the sidebar and click its broadcast icon. To stop sharing with someone, select them under Shared With and press Delete. Remove yourself from someone else’s list by deleting it.
13 PORTS. ENDLESS

OWC THUNDERBOLT 3 DOCK

Thunderbolt 3 Dock delivers more connectivity, more power, and more charging capability than ever before—all at the fastest speeds possible today. Drive two 4K displays, connect and charge up to six USB devices, work with legacy FireWire devices, enjoy pristine audio, wired networks, and read SD cards, all at speeds up to 40Gb/s and all through a single cable. The possibilities are endless.

Pre-order yours today from these fine retailers:

Macupgrades.co.uk
macupgrades.co.uk

MR Systems
mrsystems.co.uk

Academia
edu.store.academia.co.uk
LESS POSSIBILITIES.

SD Card Reader | USB 3.1 Gen 1
Expanded Analog Audio In/Cut | USB 3.1 Gen 1
S/PDIF | FireWire 800
Gigabit Ethernet | Thunderbolt 3 ports
mini DisplayPort

Supplies for Schools
suppliesforschools.co.uk

MEGAMAC
megamac.com

MacSales.com
macsales.com
7 Mail management tips

Who wants to spend more time emailing? Not us. Use these tips to speed up your time in Mail.

1 Filter out junk
In Mail > Preferences, click the Junk Mail tab and turn on filtering. You can define what the app does with junk messages, and you can exempt certain messages to avoid false attribution. This also adds a Junk mailbox in the Mailbox List sidebar, too.

2 Sort and filter
Messages are usually sorted in reverse chronological order; click the ‘Sort by’ menu at the top left of the list to change this. Alternatively, click the filter button (top right), then the filter’s description left of that to see only messages from VIPs, say.

3 Save attachments
Open a message and put the pointer over the separating line between its body and the sender’s info above it; if the message has attachments, click the paper clip button that then appears to save, open or take a quick look at them.

4 Set up VIPs
When an important contact emails you, click their name at the top of the message and choose Add to VIPs. That person’s messages then also appear in the VIPs mailbox. You can set ‘New message notifications’ in Mail’s General prefs to VIPs, too.

HOW TO Use the Favorites bar

1 Set up favourites
Choose View > Show Favorites Bar to make the bar visible. It initially includes Inbox, Sent and VIPs (if you’ve identified any contacts as such). The bar provides quick access to these mailboxes, even when the mailbox list is hidden.

2 Add new favourites
You can drag any mailbox from the mailbox list to the Favorites bar—even Smart Mailboxes. If you drag a mailbox that contains nested mailboxes, clicking it in the Favorites bar reveals a list of them from which to choose.

3 Quickly file messages
Press ⌘ + 1 and a number key to move the selected message to the mailbox in the matching position (1 to 9, left to right) on the Favorites bar; if that mailbox has others inside it, the email’s put in the most recently selected one.
1. TextEdit
Apple’s text editor may seem basic, but it’s surprisingly feature-rich. Do you want to format to a specific page size? Choose Format > Wrap to Page, and then pick a paper size in File > Page Setup. Need to export to a PDF file? Easy: choose File > Export as PDF.

It’s well worth visiting the app’s preferences, too. In the Open and Save tab, you can dictate how web pages open; by default, drag an HTML file onto TextEdit’s icon and it’ll open as formatted text rather than code – handy for quickly copying and pasting content. Change the HTML setting in the top group to see the code behind web pages, if that’s what you prefer.

In the New Document tab, the Format section dictates the default format for TextEdit itself: rich text or plain text. When editing a file, you can subsequently switch between these from the Format menu.

2. Calculator
On opening Calculator, you might dismiss it as a basic analogue of a physical model, but the app has power lurking within. It has two alternative views: click the green Zoom button or press⌘+2 to enter Scientific mode. ⌘+3 opens Programmer mode, and ⌘+1 returns to the default.

You can also use Calculator for conversions. To do so, first select a measurement type from the Convert menu, then pick units you want to go from and to. Previous conversions are kept in Convert > Recent Conversions. You can assign a keyboard shortcut to any of those in System Preferences > Keyboard > Shortcuts > App Shortcuts. Be mindful, though, as only the last 20 conversion types are stored. Shortcuts work fine if you frequently only use a few different conversions, though.

3. Stickies
The Stickies app can be a handy way of placing a temporary reminder on your display without getting it gunky from the glue of a real sticky note. Text in your sticky notes can be styled, such as big fonts to draw attention, and notes can be collapsed/expanded by pressing⌘+M. Collapsed notes show their first line of text, so make sure that’s informative.

If you have lots of notes, you can quickly organise and collapse them by choosing Window > Arrange. Also, use the Note menu’s options to fine-tune reminders you keep open on your screen – you can have sticky notes float over other windows, and make them semi-transparent so other content isn’t entirely ‘blocked’. Use the Color menu’s yellow and gray options for best results, and largish text to ensure notes are easy to read.

And the rest...
Top tips for four more apps that can save you time and help you to be more productive
SUBSCRIBE TO Mac FORMAT

Choose the perfect package for you!

PRINT & DIGITAL

> PRINT
– Get every issue of MacFormat delivered to your door at a fraction of the cover price. That’s 13 great issues every year!

£18
EVERY 3 MONTHS BY DIRECT DEBIT

PLUS!
Get 20% off Adobe’s Creative Cloud Photography plan!

> DIGITAL
– Instant digital access on your iPad and iPhone. With extra features, fully searchable articles, and more.

£15
EVERY 3 MONTHS BY DIRECT DEBIT

£6
EVERY 3 MONTHS BY DIRECT DEBIT

SUBSCRIBE
Never miss an issue

PLUS!
Get 20% off Adobe’s Creative Cloud Photography plan!

macformat.com @macformat
We’ve teamed up with Adobe for a limited time to offer you 20% off the Creative Cloud Photography plan, only when you subscribe to MacFormat.

Capture the moment, and then make it momentous with the Adobe Creative Cloud Photography plan. The world’s leading photography tools use Adobe Photoshop technology to help you craft incredible images every day, everywhere – whether you’re a beginner or a pro. It’s everything you need, all in one place.

Two ways to subscribe

www.myfavouritemagazines.co.uk/MACsubs
Or call: 0344 848 2852

Terms and conditions: Gift subject to availability and only available with Print and Complete Print + Digital bundle editions. In the unlikely event your selected gift is unavailable we reserve the right to send an alternative gift of similar value. Please allow up to 60 days for delivery of your gift. The discount code will be emailed 30 days after your purchase. Prices and savings quoted are compared to buying full-priced UK print and digital issues. You will receive 13 issues in a year. You can write to us or call us to cancel your subscription within 14 days of purchase. Your subscription is for the minimum term specified and will expire at the end of the current term. Payment is non-refundable after the 14-day cancellation period unless exceptional circumstances apply. UK calls will cost the same as other standard fixed line numbers (starting 01 or 02) and are included as part of any inclusive or free minutes allowances (if offered by your phone tariff). Your statutory rights are not affected. Prices correct at time of print and subject to change. For full terms and conditions please visit bit.ly/2kKshZw. Offer ends 30/04/2017.
LOSE YOURSELF IN A WORLD OF Vinyl

FIND YOURSELF IN OXFAM’S ONLINE SHOP

oxfam.org.uk/shop
**APPLE SKILLS**

EDITED BY ALAN STONEBRIDGE

NEW IDEAS
Your new-look guide to getting more from your Apple kit

TURN AN IPAD INTO A TOUCH BAR FOR MAC

What’s inside

50-52
**MAKE YOUR OWN TOUCH BAR**
➤ Turn your iPad into a Touch Bar for your Mac

54-55
**STAY SAFE ON PUBLIC WI-FI**
➤ Use a VPN to set up a secure connection

56-57
**BOOST EDITING TOOLS IN PHOTOS**
➤ Add Affinity Photo controls to Photos

58-59
**BLOCK NUISANCE PHONE CALLS**
➤ Stop annoying telemarketing calls

60-61
**REMOVE MALWARE WITH EASE**
➤ Control which apps can access your data

63
**GET A GOOD NIGHT’S REST**
➤ Improve your routine with iOS 10’s Bedtime

64-67
**SPEED UP AN OLD MAC**
➤ Let Elementary give your old Mac a new lease of life

---

**Understand iOS gestures**

➤ A tap is a brief contact of (usually) one finger on your device’s screen.
➤ To drag is to move a finger across the screen to scroll or pan around content.
➤ Swipe means move one or more fingers across an item or the screen, then let go.
➤ A flick is like swiping, but it’s quicker, and is often used to scroll content more quickly.
➤ Pinch means move two fingers together or apart, usually to zoom in or out.
➤ Touch and hold means lightly rest your finger on an item and wait for a reaction.

**Master Mac keyboard shortcuts**

➤ When you see a shortcut like \(\text{⌘}+\text{⌥}+\text{C}\), hold all but the last key, then press that one.
➤ \(\text{⌘}\) is the Command key, which is also labelled cmd.
➤ \(\text{⌥}\) means the Option key, labelled alt or opt.
➤ \(\text{⌘}\) means the Control key, labelled ctrl, and shown as ^ in shortcuts in the menu bar.
➤ \(\text{⌥}\) is the Shift key, which is typically just labelled shift.
➤ \(\text{⌫}\) means the Delete key, which deletes to the left of the insertion point. Press \(\text{⌘}+\text{⌫}\) to delete to the right.
➤ \(\text{⇥}\) is the Tab key, which shifts the focus between some controls in windows and web forms. Turn on Full Keyboard Access in System Preferences to jump between all controls.

---

APRIL 2017 | MACFORMAT | 49
Make your own Touch Bar

Discover benefits of Apple’s input innovation and turn your iPad into one

It will take
› 20 minutes

You will learn
› How to see what a real Touch Bar would offer you, and how to use your iPad as one.

You’ll need
› An iPad with iOS 7 or higher, and a Mac with OS X 10.9 or higher.
› Duet Display.

Even if you have a proper Touch Bar, read on for tips on getting the most from it

Apple’s Touch Bar technology puts context-sensitive controls at the top of the keyboard in the hope of saving you time digging around in menus and windows to find the commands you need. Currently, the only official way to get a Touch Bar is to buy a MacBook Pro, and even if Apple were to update its Bluetooth-connected Magic Keyboard to include one, it’s unlikely to be affordable given the existing model costs £99.

However, you can add a Touch Bar to your existing Mac by adding an iPad and third-party software into the mix. If you don’t have an iPad there’s a Mac app that enables you to see what the Mac’s latest control method would add to your apps if you were to upgrade.

Be aware, though, that there’s one aspect of the real thing that you can’t replicate using the following methods: a Touch ID sensor for unlocking your Mac, validating payments online, waking your Mac, and more. (A real Touch Bar has a combined Touch ID sensor and power button at its right end.) That said, there are other ways to imitate some of the sensor’s benefits; MacID (£3.99, macid.co) enables you to unlock your Mac using the Touch ID sensor on your iPhone or iPad.

However, the bigger bonus of having a Touch Bar to hand is the range of time-saving shortcuts it provides in apps bundled with macOS, as well as a growing number of third-party ones, which includes OmniGraffle 7, 1Password and Mail Designer Pro 3.

If you have a Mac with a built-in Touch Bar, don’t assume these pages are irrelevant to you; whether you’re using the real deal or an iPad as a stand-in, you’ll find tips later on in this tutorial on how to tailor the bar’s contents and ensure you’re getting the most from it.

Try it out for free
Any Mac that’s running macOS Sierra 10.12.2 or higher is silently generating the content that would be displayed on a Touch Bar if one were present, it just doesn’t have anywhere to show it. Also, macOS knows how that content should behave if you had a way to interact
The quickest way to see what a Touch Bar would offer you is Touché, a free utility from Red Sweater Software that renders macOS’s internal model of the bar in a window. The app isn’t simply a dumb display of that content, though; where you would tap or swipe controls on a real Touch Bar, you can click or drag them on Touché’s window to get the same effects. This doesn’t give you a true feel for the real thing, of course, but it’s a good way to investigate the shortcuts your favourite apps would provide, given the right hardware.

Get Touché from red-sweater.com/touche, unpack the archive, move the app to the Applications folder, then open it. You can place Touché’s window where you want—near the bottom of the primary display is probably best.

When Touché is running, macOS will reveal customisation options for the Touch Bar in System Preferences and compatible apps, which we’ll discuss later.

The better (but paid) option
For an experience closer to a real Touch Bar, you’ll need an iPad and its USB cable, and Duet Display (£19.99, duetdisplay.com). We’ve talked about this app before (notably in MF298, where we discussed its primary purpose of extending a Mac’s desktop onto an iOS device. Duet 1.6.3.4 for Mac and 1.3.7 for iOS enable the app to render the Touch Bar at the bottom of your iPad’s screen, covering up a little strip across the bottom of the extended desktop. With your iPad propped up behind your keyboard—ideally a low-profile one, such as the Magic Keyboard—you end up with a rough but usable approximation of a real Touch Bar. Depending on the arrangement of your desk—say, if your primary display is raised high enough that your iPad doesn’t obscure your view of it—this has the added advantage of giving you more space on which to stash apps you glance at only occasionally.

Customise your Touch Bar
By default, the Touch Bar displays contextual app controls on its left side and across most of its width, and a shortened Control Strip of system-wide controls towards its right end. Tapping the arrow at the left of the Control Strip expands it temporarily, filling the bar with additional items that appear in the top row of a regular Mac keyboard; you won’t need these with Touché or Duet Display because you already have real keys for this function, but you can change the Control Strip’s contents to include other shortcuts that

Jargon Buster
The Control Strip is also the name of a similar on-screen set of system controls that appeared on classic Macs back in the 1990s.
usually require multi-key combinations, which you may have trouble remembering; we particularly like the single-key shortcuts for locking the screen, putting our Mac to sleep, and taking a screenshot. The latter of these even offers the ability to open screenshots in Preview immediately, or to file them in the Documents folder instead of on the Desktop.

In the walkthrough below, you’ll learn how to customise what your Touch Bar displays by default and when you hold down \( \text{fn} \), and how to alter the Control Strip’s contents. You can tailor the Touch Bar in more ways, too; some apps that support it enable you to pick which of their controls are pinned to it. So, in Safari you can add controls to add a bookmark, open the Share menu so you can use the arrow keys to choose from it rather than having to reach for your mouse or trackpad, or view the current page in Reader mode. Look for a Customize Touch Bar item in an app’s View menu. While customising the bar, note the ‘Show typing suggestions’ checkbox; clear it if you don’t want predictive text suggestions, like those on an iPhone, to appear in the bar.

There’s one thing to beware of when using Duet Display: on a Mac that had a secondary display already, we found Duet’s Touch Bar would was sometimes blank. Disconnecting the existing secondary display resolved this, so you should find Duet works fine if your Mac currently has one display.

Alan Stonebridge

### HOW TO Customise the Touch Bar’s contents

1. **Get started with Duet**
   - Install Duet Display on your Mac and iPad and open both versions. It should detect your iPad automatically. To show the Touch Bar on your iPad, click Duet’s menu bar icon, put the pointer over your iPad’s name and click Touchbar Enabled.

2. **Set what the bar shows**
   - Go to System Preferences’ Keyboard pane and stay on its Keyboard tab. Click the ‘Touch Bar shows’ pop-up menu: the bar can show contextual app controls and a compact Control Strip, only app controls, or the expanded Control Strip.

3. **Set alternate contents**
   - Holding \( \text{fn} \) usually shows numbered function keys in the Touch Bar. If you’ve no use for these, use the ‘Press Fn key to’ pop-up to set this to show the expanded Control Strip or App Controls; what’s offered depends on your choice in step 1.

4. **Customise Control Strip**
   - At the bottom right of the Keyboard tab, click Customize Control Strip to see items you can add, including some that aren’t used by default; those shown differ based on whether the strip is currently in its compact or expanded form.

5. **Alter its expanded form**
   - Drag a control from the selection shown on the main display and move it over the bottom edge so it appears with a blue highlight on the Touch Bar, then drag left or right till it’s in the position where you want it, then let go.

6. **Rearrange items**
   - To rearrange Touch Bar items, move the pointer over the bottom edge of the main display (this time without dragging anything). One bar item (or group) is highlighted: move left or right to choose the one to move, then drag it left or right.
1,500 FOOTBALL PITCHES EVERY DAY!

Did you know that European forests, which provide wood for making paper and many other products, have grown by 44,000km² over the past 10 years? That’s more than 1,500 football pitches every day!†

Love magazines? You’ll love them even more knowing they’re made from natural, renewable and recyclable wood.

Stay safe on public Wi-Fi

Set up macOS Server for a secure internet connection from anywhere

If you frequently access the internet through other networks, such as a public Wi-Fi hotspot, you should use a virtual private network (VPN). Using a VPN provides you with a secure, encrypted connection over any network, even insecure ones. A VPN is typically used to provide a secure connection to a private network, such as a server at home or in the office, but you can also use it to access specific online services - to browse the web, check email, and so on.

Third-party VPN services are either costly or come with limits such as time or connection speed. The good news is that by installing macOS Server (£19.99, Mac App Store) on an always-on Mac, you can use its built-in VPN service unrestricted and at no extra cost. The connection will be a little slower than an unencrypted network, but it’s a small price to pay for security.

The walkthrough here shows you how to configure macOS Server’s VPN - note that it’s incompatible with the Back to My Mac feature on AirPort Extreme and Time Capsule routers, so you’ll need to disable that for it to work. You’ll also need to know your public IP address, which is the one assigned to your router by your internet service provider to identify it online. As this can change over time (unless you subscribe to a service that assigns a static address), it’s simpler to employ the services of a web-like dynamic DNS address - for example, yourname.ddns.net - that stays linked to your internet connection’s public IP address even when the latter changes.

NoIP.com provides a free Dynamic DNS address you can use in conjunction with your VPN to ensure it’s reachable.

In Network preferences is an option to add a status icon to the menu bar so you can easily connect to your VPN.

You can get a free address at noip.com: enter a hostname, choose one of four domains (hop.to.org, zap.to.org, sytes.org or ddns.net), then click Sign Up and provide your personal details. You’ll need to reconfirm this every 30 days; you’re reminded by email to do so. If your connection’s public IP address changes often, consider using the Dynamic DNS Update Client (noip.com/download) to promptly link the new one to your dynamic address.

Connect to your VPN

The final step opposite shows how to create a file you can transfer to your other Macs to simplify connecting to your VPN from them. When prompted during connection, enter the account name you want to log on as, which you’ll have set up under Users in Server. If transferring a file is impractical, go to System Preferences > Network on the Mac you want to connect from, click +, and then choose VPN as the interface and L2TP over IPSec as the type. Under Server Address enter your dynamic address, and under Account Name enter the account you want to log on as. Click Authentication Settings to fill in your account password and the required shared secret, and you’ll be good to go. To connect your iPhone or iPad, go to Settings > General > VPN.

If you have a third-party firewall running on your server, you may be prompted to approve the connection when you first try to log on to the VPN; once allowed, you’ll be able to rely on a secure, encrypted connection whenever you go travelling. Nick Peers
HOW TO Set up a VPN server

1 Prepare an Apple router
Open AirPort Utility and ensure Back to My Mac is disabled. On the Internet tab, click Internet Options and turn on ‘Use dynamic global hostname’, then enter your dynamic address and your DDNS account credentials. Click Save.

2 Third-party router setup
When using an Apple router, the Server app will set up all required ports for you, so click Update to finish and then skip to step four. If you have a third-party router, though, start by giving it your dynamic address and DDNS account.

3 Forward ports
You’ll also need to manually set your router’s port forwarding settings to open the necessary ports for the VPN. Create separate rules to forward ports 500, 1701 and 4500 (all using the UDP protocol) to your server’s IP address on your network.

4 Set up macOS Server
Open the Server app on the Mac you’re using as a server. Click Edit Host Name on the main screen, click Next, verify the correct connection is selected (Ethernet or Wi-Fi), then click Next again and select Local Network and VPN.

5 Finish the host name
Click Next, then change Host Name to something more descriptive – for example, server.yourname.private. Click Finish followed by Change Host Name, click Set up DNS, leave the default settings alone, and then click Save.

6 Enable the VPN
Select VPN in the left pane. Set the VPN Host Name item to your dynamic DNS address. Reveal the current shared secret and change it if you want, but avoid an easily guessable password. Use the switch (top right) to turn on the VPN.

7 Verify the VPN is on
If you’ve configured your ports and dynamic address correctly, you should see confirmation that the VPN server is ‘reachable over the internet’ – if the VPN page says it can’t determine reachability, review your settings.

8 Tweak settings
Click Edit Permissions if you want to restrict VPN access to specific users only. Click Edit Addresses to ensure the VPN assigns IP addresses to remote devices that won’t clash with your router’s DHCP server. When done, click Restart VPN.

9 Send to other Macs
Click Save Profile to create a file that simplifies setting up other Macs to connect to the VPN. Transfer the file to another Mac, double-click it there, then follow the prompts. To connect to the VPN, use the Network preferences pane.
Boost Photos’ editing tools
Add Affinity Photo’s image manipulation tools to Apple’s photo manager

IT WILL TAKE
10 minutes

YOU WILL LEARN
How to add Affinity Photo’s controls to Apple’s Photos app.

YOU’LL NEED
OS X 10.11 or higher. Affinity Photo from the Mac App Store.

The benefit of using an app like Lightroom, or Apple’s now-discontinued Aperture, is that you get all the tools you need to manage, edit and export photographs in one place. Neat and tidy, right? What might not be immediately obvious is that Apple’s Photos, the apparently consumer-focussed photo management app provided with macOS, provides you with a surprisingly powerful set of ‘roundtripping’ tools.

Roundtripping is the practice of opening an image in one app, exporting it directly to another app to make changes, and then returning those changes to the original image in the first app. Photos’ version of this uses Extensions, which are tools supplied by other apps that you use within Photos’ own window.

Whether you round-trip an image or simply use an extension within Photos, you can get hold of far more advanced image editing tools than are available in Photos ordinarily, while continuing to take advantage of Photos’ ability to organise and attach metadata such as locations and perform face and object analysis on people and items in your images, giving you the best of both worlds.

Adding new extensions to Photos is easy. Once you’ve installed an app that includes one or more of them – Affinity Photo is just one; Aurora HDR and Luminar are other examples – open a picture in Photos’ editing mode (see the Genius Tip on the opposite page for a shortcut). On the right you’ll see Photos’ own editing tools – click Extensions at the bottom, and pick More if you don’t see your app’s extensions in the list; this takes you to the System Preferences’ Extensions pane and shows all the photo-editing ones on your Mac. Check the boxes of those you want to use.

In Affinity Photo’s case, Extensions work in two different ways: most of them make tools from Affinity Photo available directly within Photos’ interface. The ‘Edit in’ one, though, passes your image to Affinity Photo so you can use its full toolset. The edited version is reimported into Photos when you save and close it. Dave Stevenson
How to Use Affinity Photo’s extensions

1. **Add Affinity Photo**
   - Select an image in Photos and press `cmd` to switch to the app’s editing mode. At the bottom of the tools on the right, click Extensions and choose More to see those that are installed; add check marks to those you want to use.

2. **Edit in Affinity Photo**
   - Here we want to replace the overexposed sky with a nicer one. This kind of cutout work can only be done by choosing Edit in Affinity Photo. When you do so, that app will spring into life and the picture will open in it.

3. **Finish the job**
   - After making changes in another app, to complete the round trip back to Photos press `cmd` + `s` to save your edits, then `cmd` + `w` to close the picture. If you don’t close it, your changes won’t successfully return to Photos.

4. **Reset your image**
   - If you later decide an edit wasn’t quite what you wanted, don’t worry; the original data is still present. Remember you can always choose Image > Revert to Original in Photos. Your original shot is never lost!

5. **Editing within Photos**
   - Only a few extensions require you to pass pictures to third-party apps; others work within Photos. Click Extensions again and pick Affinity Haze Removal. This provides a very useful way to remove low contrast from landscape photos.

6. **Haze removal**
   - Adjust the Distance and Strength sliders and drag the before/after divider to check the results; if the pic is too dark, use the Exposure Correction slider to fix it. Click Save Changes to return to Photos’ normal editing mode.

---

Jargon Buster

> **Roundtripping** is the process of exporting a document or image from an app, working on it in another app, and then returning its edited state back to the first app.

Genius Tip!

> Using one extension doesn’t mean you can’t also apply Photos’ tools or other extensions; use as many as it takes to get your desired result.
Block nuisance calls
Make sure fraudsters, phishers and telemarketers can’t talk to you

IT WILL TAKE
15 minutes

YOU WILL LEARN
How to report and stop annoying or risky numbers that keep calling you

YOU’LL NEED
iOS 9.0 or higher

Hiya warns you on the Phone app’s incoming call screen about suspected scam callers

These days it’s easier than ever to stay in touch with people all over the world, but it has a downside in that it’s also easy for unsolicited calls to reach you. One cause of this can be that you’ve given your personal data to social networks, apps or services, perhaps because they require it as part of setting up an account.

Even if you trust that they won’t share your details, a security breach could leak data and lead to fraudsters, phishers, and identity thieves calling you to try to do you harm – not to mention the barrage of telemarketers or phoney PPI organisations that, should your number get onto one of their databases, will hound you day after day.

This is where Hiya (free, apple.co/2kI5Qsg) tries to help you out: it maintains a database that collates the numbers of known spammers and scammers, and will warn you when one is trying to call; on the Phone app’s incoming call screen, Hiya adds a yellow alert for spam calls from the likes of telemarketers and surveyors, or a red ‘No entry’ shield next to any number it identifies definitively as a “scam or fraud” – and you have the option to block both and pass them to voicemail. This is possible thanks to CallKit, part of iOS 10 that enables third-party apps to augment your iPhone’s call blocking and identification services.

You can help boost Hiya’s effectiveness, too: within the app there’s a page for reporting or blocking unwanted numbers; the info you provide is sent back to Hiya’s developer, which, after a number is reported enough times, will add it to the public database. That database is updated daily – and automatically, so you don’t have to worry about constantly installing app updates – so that everybody using Hiya is protected as quickly and easily as possible, all thanks to community efforts.

Make preparations
One thing that might raise concern when you first open the app is that it asks for permission to access your contacts. According to Hiya’s privacy policy, this is to “filter out numbers that may look spammy, but are actually legitimate (like your Doctor’s office)”. After you’ve run through the app’s intro, go to Settings > Phone > Call Blocking & Identification and ensure the switch next to Hiya at the top of the page is on. Then read on to learn how to work with Hiya to avoid answering unwanted callers. Adam Smith

HOW TO Look up information about a number

1 Copy the number
To find out more information about a possibly fraudulent or spam call you’ve received, open the Phone app, go to the Recents tab, tap the circled ‘i’ next to the call, and then hold down on the number near the top of the screen to copy it.

2 Paste it into Hiya
Next, open Hiya. It should recognise there’s a phone number on the Clipboard and ask if you want to look up its info; tap Yes to go to the Identify tab. Otherwise, paste the number into that tab’s search bar, then tap the suggestion to identify it.

3 Review the caller’s info
Hiya will search its database for any info it has about the number, such as whether it’s a mobile or landline. It also gives you options to report or block the number, along with a summary of other people’s previous experiences of it.
HOW TO Tailor actions for spam and scam calls

1 Explore Hiya's options
   Go to Hiya's Options tab; this is where you can access the app's frequently asked questions (FAQ) page, contact its support team by email, and, most crucial of all, tailor how you want the app to respond to suspicious calls.

2 Block spam
   For low-threat calls (those classified as spam), you can choose whether Hiya should alert you by adding a yellow sign next to the caller ID on the incoming call screen, or simply block spam by default and direct it to voicemail.

3 Defend against fraud
   For calls that pose a higher risk to you, such as those from fraudsters or other malicious individuals, you can also choose to send them to voicemail too, or be given a clear warning with a red 'no entry' sign on the incoming call screen.

HOW TO Take action over an unwanted call

1 Report a call
   In the event you receive an unwanted call, it's time to take action. You have the option to report it to Hiya's developer in the Identify tab. You can also block the number from there, or go to the separate Block tab to manually add numbers.

2 Categorise the call
   When you tap the Report button, you can choose from a list of categories so that Hiya can correctly classify the number. Or, you can instead mark the number as Not Spam in order to improve inaccuracies in Hiya's database.

3 Provide more detail
   Once you've chosen your category, you have the option of providing more specific details about the information the caller was trying to get from you, such as credit card information, or telling you to install harmful software.

Add an extra layer of protection
A measure to keep your main number private

Thousands of spammers and fraudsters are added to Hiya's database each day, so hopefully you'll find it useful in reducing the number of unwanted calls that you pick up. However, while Hiya can protect you from the symptoms of spam calls, ensure you also take steps against the cause. Try unlinking your number from social media accounts, or use an app like Sideline (apple.co/2kh99Dd) to provide you with a second phone number to use, which is especially helpful when you're unsure whether to give an organisation your main mobile number.
Remove malware with ease
Control which apps can access your files and your Mac’s mic and webcam

Little Flocker is designed to keep the data on your Mac safe from a whole range of nasties including malware, trojans, backdoors, and badly behaved apps that try to access files or features they shouldn’t. As well as protecting files, it can force apps to ask you before they access your Mac’s mic or webcam, for example. It also ensures apps get explicit permission to install startup items, take control of other apps, and eavesdrop on your internet connection.

Little Flockr makes it clear to you when your mic or webcam is in use, or when an app is intercepting clicks or keyboard strokes – thus keeping you safe from keyboard logging tools. And, importantly, it will prevent malware from taking control of other apps or running from your user account’s Home folder.

As well as protecting you from malware that can steal your data, Little Flocker can also help to keep your Mac running smoothly by preventing apps from installing junk that could slow it down.

Is there a downside? Only if you’re put off by a challenging learning curve or by dialog boxes popping up every time a threat is detected or permission is required. If those are an issue, you’ll have to decide for yourself whether the effort and inconvenience is worth the additional layer of security.

Get to grips with it easily
The learning curve can be alleviated by using Simple Mode, which replaces Little Flocker’s detailed list of settings and configuration options with a much simpler interface. Simple Mode is active by default when you first run the utility, and it enables you to easily specify permissions for apps, for example. However, it doesn’t protect your Mac from trojans, nor does it provide the detailed options that are available in the main app window.

That’s where we come in. On the page opposite, we’ll show you how to configure Little Flocker so that it’ll keep your data safe and your computer running smoothly.

Kenny Hemphill
1 Import rules on first run
When you first run Little Flocker, it analyses your Mac's startup items and creates rules for them. In the dialog box that pops up, uncheck any you don't want to import, then click Import.

2 Check blocked activities
Click on Little Flocker’s status icon in the menu bar, then choose Preferences. Under Policy is a list of activities that are blocked by default. Uncheck any you want to allow without having to give permission each time.

3 Clicks and key presses
Some apps, such as screen sharing, need to simulate interactions to work. To allow this, open Little Flocker’s preferences and, under the Security heading, enable ‘Allow software-composed mouse clicks and keypresses.’

4 Create a rule
From Little Flocker’s menu bar icon, pick Little Flocker Configuration. Click New Rule in the toolbar, choose an app, and then use the Browse button to choose a folder you want to allow or deny access to by that app.

5 Specify how the rule works
In the same window, decide whether to allow the app to be able to read, write or create files in that folder, and whether you want it to be able to execute from that path or mount volumes. When your rule is set up, click Save.

6 Enable Simple Mode
If you just want basic protection, click on the menu bar item and click Enable Simple Mode. This grants access to an entire folder, giving you less control but decent protection without having to allow every file path.
PHONES WEARABLES AUDIO TVS CARS HOME

IGNITE your world with the ULTIMATE LIST of today's TOP TECH, GADGETS and PEOPLE

The Gadget Magazine

HOT 100

4K OLED TVs • SAMSUNG GALAXY S8 • NEXT-GEN GAMING • STEVE HOROWITZ • HOME ROBOTS • SMART HOME 2.0 • CONNECTED CARS • ELON MUSK

BEST WIRELESS SPEAKERS
HI-RES MULTI-ROOM SYSTEMS RATED

ON SALE NOW!
AVAILABLE AT WHSMITH, MYFAVOURITEMAGAZINES.CO.UK OR SIMPLY SEARCH FOR T3 IN YOUR DEVICE’S APP STORE

SUBSCRIBE TODAY AND SAVE! SEE WWW.MYFAVOURITEMAGAZINES.CO.UK/T3
Get a good night’s rest
Use iOS’s Bedtime feature to ensure you get some quality shut-eye

You may think you know about every single way you can use the Clock app, but in iOS 10 it has gained a new feature, Bedtime, that’s well worth checking out.

As its name suggests, it’s all about helping you get a good night’s rest, and it’ll also give you some insight into your sleep patterns.

Tap Bedtime’s icon in the app’s bottom bar and you’ll be asked a few questions, one at a time, such as how many hours sleep you need, when you want to be woken up, and how far in advance you want your device to prompt you to get ready for bed. The last of these can be set to occur up to an hour before bedtime, enabling you to attend to the day’s final tasks, or you could treat it as a prompt to set aside devices that may be keeping your mind active.

If you already make use of the Clock app’s Alarms feature, rest easy in the knowledge that instructions you give to Siri, such as “Delete all of my alarms” and “Turn off my alarms”, don’t affect Bedtime’s wake-up call.

In contrast to alarms, Bedtime offers a more gentle selection of sounds to rouse you from your slumber – so gentle that until you’ve tried it out for at least a few days, to ensure your pick of sound effect and volume are effective, we recommend you keep a regular and more boisterous alarm set for shortly after Bedtime’s wake-up call to ensure you don’t end up being late for work.

Complementary features
Once you’ve set up your bedtime schedule, it’s worth complementing it with iOS’s Do Not Disturb and Night Shift features. The former ensures only essential communications get through to you between certain hours; go to Settings > Do Not Disturb to configure when it’s active, and optionally to allow a group of people you’ve set up in the Contacts app to get through to you anyway – useful for relatives or if your job requires you to be available on call, say.

Meanwhile, Night Shift reduces the amount of blue light output by your device’s screen so that it’s warmer, ostensibly to help you relax late in the day. To set it up, go to Settings > Display & Brightness. The effect will appear extreme when you enable it for the first time, but you’ll grow accustomed to it after a few days, after which disabling it (from Control Centre) will make the colder, blueish output appear harsher than you may remember late at night. Alan Stonebridge

HOW TO Manage and monitor your sleep patterns

1 Sleep and wake times
After running through Bedtime’s initial set-up steps, its page shows a switch that toggles it on or off. When on, drag the alarm and moon icons on the clock face to set bed and wake times; your sleep’s expected duration is shown in the middle.

2 Scheduling and sounds
Tap Options to set days on which the feature is active and how long before you’ll be reminded to wind down. You can pick the sound that’ll wake you (vibrate only also an option), the volume it’ll build up to, and have your iPhone vibrate, too.

3 Review your rest
With your iPhone next to you, it’ll analyse your movements. The current week’s sleep is visualised at the bottom of the page; tap ‘More history’ to look further back and correlate with data from accessories or entered manually.
Elementary is designed with an eye on attracting Mac users with its similar, friendly overall looks.

**Elementary provides your aged Mac with a modern, updated operating system and a whole new lease of life.**

---

### Speed up an old Mac

**Discover Elementary, a Mac-like operating system that’s kept up to date.**

**IT WILL TAKE**
- 2 hours

**YOU WILL LEARN**
- How to set up a dual-boot Mac running OS X and Elementary.

**YOU’LL NEED**
- Dual-core Intel Mac.
- 1GB memory.
- 30GB free space.

Do you have an old Mac that’s incapable of running a recent version of OS X and so doesn’t receive important security updates to apps such as Safari? That Mac may otherwise be functioning perfectly well, and it’d be a shame to get rid of it.

Thankfully, there’s an alternative operating system, called Elementary, that will keep your old Mac in service, with a desktop environment that’s designed with an eye on attracting Mac users thanks to its similar, friendly interface. It’s also lightweight, making it perfect for older Macs that are showing their age, and it comes with the essential apps you’ll need.

In this project you’ll learn how to install Elementary alongside your OS X installation (and Boot Camp installation of Windows too, if you have one), and how to switch between them as needed. Although light on resources, Elementary requires a reasonably fast dual-core processor with at least 2GB RAM, so you’ll need a Mac from about 2006 onwards, running OS X 10.6.8 or later.

Before you go any further, we suggest you try out Elementary first. The simplest solution is to install Elementary in a virtual machine within VirtualBox (free, virtualbox.org); when setting up the virtual machine, select the Ubuntu 64-bit option, which Elementary is based on. Mount the ISO file (see below) as a virtual DVD drive and you’re good to go.

If you decide to then install Elementary as a startup option for your Mac its own right, perhaps to use as its primary operating system, it pays to take some precautions. Start by making a full backup of your entire hard drive, so you can roll back if things go awry. Use a tool like Carbon Copy Cloner (around £35, bombich.com), and create rescue media that you can use to restore your Mac to its state from before you began this tutorial.

**Create install media**

First, download Elementary in ISO format. Go to elementary.io, where you can enter 0 in the Custom field to avoid paying for it, then click ‘Download elementary OS’. Save the ISO file.
Keep an old Mac in service  

APPLE SKILLS

April 2017  
MACFORMAT  
65

Use Disk Utility to free up space on your hard drive for Elementary to reside on.

Though Installing the rEFInd boot manager means using Terminal, it’s a reasonably straightforward affair.

Use Disk Utility to free up space on your hard drive for Elementary to reside on. To your Mac’s hard drive – it’s more than 1GB in size. Once done, download and install Etcher (etcher.io). You’ll also need a 2GB or larger flash drive; with only one USB drive plugged in, open Etcher, click Select Image and select the ISO file and Etcher should automatically select your flash drive. Click ‘Flash!’, enter an admin account’s name and password, and wait for Elementary’s files to be copied to the drive. When this completes, you’ll be told the drive isn’t readable – this is normal, so click ‘Ignore’.

If you don’t have a suitable flash drive, you can pop a blank DVD into your Mac’s DVD drive instead, click the ISO file and choose ‘Burn Disc Image’ instead. Note that installing from a DVD is noticeably slower.

This project is really for versions of OS X that no longer get updates, but if you want to run Elementary alongside El Capitan or Sierra, see the extra details on page 66.

Install a boot manager

Next you need to install a boot manager that enables you to switch between OS X and Elementary. This will appear every time you start up your Mac, and shows icons for the available systems; Use the arrow keys to highlight one and press □ to choose it.

Download rEFInd from bit.ly/2kKdZM0: click the ‘binary zip file’ link and save the file to your Downloads folder. If Safari doesn’t automatically extract the Zip file’s contents, double-click the file in Finder to do so.

Open the folder this creates, then open Terminal from /Applications/Utilities and drag the refund-install script file from the folder onto Terminal’s window so its name appears in the command line. Press □ and enter your password to install rEFInd. It should end with an “Installation has completed successfully” message. Restart your Mac and you should see the rEFInd boot menu; it’ll always default to the last system you started up in.

Partition the hard drive

The final preparation step is to free up space on your hard drive for Elementary to reside on. You’ll need to take this space from your existing Mac partition (Boot Camp is off limits,

Jargon Buster

Extensible Firmware Interface (EFI) provides a software interface between your Mac’s hardware and its operating system.

Genius Tip!

If Elementary can’t add a boot loader during its installation, run rEFInd’s setup process again within OS X to add the required entry.
so you’ll have to take unused drive capacity from your OS X partition. Look to take a minimum of 20GB, or more if you plan to make Elementary your primary operating system on this Mac.

Open Disk Utility, select your hard drive on the left (not a volume on it) and click the Partition tab. Select OS X’s partition and reduce its size by the amount you want to give to Elementary. Click Apply > Partition, then leave the newly free space as it is. You’re now ready to embark on the installation process. To do so, follow the step-by-step guide opposite.

After installing Elementary

When the installation finishes, your Mac will restart straight into Elementary. But wait: what’s happened to rEFInd? It’s been supplanted by Elementary’s own boot loader, but you can restore it: open the Epiphany web browser and download the same binary Zip file as you did earlier. Choose Applications > Files from the menu bar, go to the Downloads folder, and then right-click the Zip file and choose ‘Extract Here’.

Open the newly created rEFInd-bin folder, then right-click inside the Files window and choose ‘Open With > Terminal’. Finally, type ./refind-install, press RETURN, then enter your account password and press RETURN again; a series of messages should appear confirming that rEFInd is the default boot manager once more. Finally, restart your Mac and you’ll find that you’re now able to easily switch between OS X and Elementary.

If you use El Capitan or Sierra

To install Elementary alongside these systems, you must temporarily disable System Integrity Protection. Restart your Mac and hold down CONTROL + R till the Apple logo appears. When the Recovery system starts, choose Utilities > Terminal, type csrutil disable, press RETURN and restart the Mac. After installing the rEFInd boot manager, you can turn SIP back on; choose the Apple Recovery option from the boot manager; in the Recovery system, pick Utilities > Terminal as before, but this time type csrutil enable to re-enable SIP, then restart. Note: reinstalling rEFInd requires you to disable SIP first.

When prepping storage for Elementary, Disk Utility won’t let you create free space; it insists on creating a partition you must later delete when installing Elementary. Select the disk itself and click Partition. Verify you have enough free space, then click + to add a new partition. Set its format to FAT32 to make it easier to identify, and set its size accordingly, then click Apply and wait for it to be created.

When you reach the ‘Something else’ screen in Elementary’s installer, you’ll need to delete the FAT32 partition, then use the resulting free space as instructed. Nick Peers
HOW TO Put Elementary on your Mac

1 First steps
After partitioning your Mac’s hard drive, restart with the Elementary install media connected. Select the Penguin icon from the rEFInd boot manager, then choose install Elementary OS and press to continue.

2 Connect to network
When the installer appears, select English and click Continue. Connect to your Wi-Fi network if prompted. Once done, tick both boxes to download updates and third-party software, then click Continue again.

3 Choose installation type
Elementary won’t be able to detect your OS X installation, so choose ‘Something else’ at the next screen and click Continue. When the partition table appears, select the free space you set aside earlier and click the + button.

4 Create required partitions
Set the size in ‘Create partition’ box to 4096MB to create a swap file 4GB in size (ample for most setups), select ‘End of this space’, click the ‘Use as’ pop-up menu and set to ‘swap area’, and then click OK.

5 Finalise partitioning
Select the remaining free space and click + again. Leave all the settings alone except for the ‘Mount point’ – click this and set it to just a forward slash (/). Click OK and then install Now. Review the changes and click Continue.

6 Complete installation
The rest of the installer’s self-explanatory; verify your time zone and keyboard layout, then provide a username, computer name and password. Once done, the installation should proceed to a successful conclusion.

Jargon Buster
System Integrity Protection (SIP) is a security feature of El Capitan and Sierra designed to protect against various threats. It also catches out a few things you might want to do, like installing another boot manager.

Genius Tip!
In System Preferences’ Startup Disk pane, pick the volume containing OS X and click Restart to disable rEFInd. To then bring back rEFInd you’ll need to reinstall it.
THE ULTIMATE macOS Sierra HANDBOOK

The No.1 guide to making the most of your Mac

624 Sierra secrets

- Do more with iCloud
- Master the Photos app
- Take control with Siri

Buy your copy today!

What’s the best way to free up storage on my Mac?

Q My 2011 MacBook Pro, with a 320GB drive, is running out of space. Much of its storage is being taken up by music and movies. Can I move them to an external drive, or put them in the cloud?

A Apple provides storage as part of iCloud, but to free up a lot of space on your Mac, you’ll have to rent more on iCloud – you get 5GB for nothing, and if you want more, you’ll incur a monthly charge; you can have up to 2TB of iCloud storage at this time - see apple.co/2jBePMe for pricing.

For movies and TV shows bought from the iTunes Store, it’s simplest to stop storing them locally. You’ll only want to watch one or two movies in the next day or so; leave those on your Mac, and remove all other movies and TV shows – you can redownload them later on.

In iTunes, select a film that’s stored locally, then choose Film > Remove Download. To watch it, you’ll need to download it again, but it remains available and costs nothing extra to redownload (unless your internet service provider charges for heavy bandwidth usage). Do this for TV shows and other large content, such as iOS apps downloaded through iTunes.

You could move your iTunes Library to an external drive, but it'll only be available when that’s connected. Consider adding a special SD card that fits entirely in the SDXC slot. Be wary of using apps that claim to ‘clean up’ storage, though a tool like DaisyDisk can help identify what you might move to such SD storage.
**Mac Hardware**

Thinking outside the aluminium box to find solutions to your toughest Mac problems

**What’s up with text legibility?**

**Q** Most of the time, the contrast on my 2012, 15-inch MacBook Pro is insufficient for reasonable reading. I’ve tried adjusting the display’s contrast along with Accessibility settings to no avail. Is there any other way of making the system characters darker so they contrast better?

by **STEWART DAVIS**

**A** There are probably three interlinked issues: macOS’s system font, which many find too ‘thin’ to show sufficient contrast against white; font size, which forces most elements in glyphs to be a pixel thick; and the actual blackness of display black.

Ruling the third out is easiest to do. Find a matte surface that appears fully black, and compare it against a black rectangle on the display. If the latter only appears dark grey, your Mac has a display problem. You can confirm that by setting it against a known good display. If you can’t correct that using the Calibrate feature in the Displays pane’s Color tab, there may be a problem in the graphics processor or, more likely in an older Mac, the display itself.

The other two things can be checked by comparing different fonts and sizes in a text-oriented app against the system font. Unfortunately, many people who experience similar problems don’t find the Accessibility pane’s tools to be much help in addressing them, unless they go to the extreme of using its Zoom feature, which brings its own costs.

Important adjuncts to this include the adjustment of ambient lighting to suffuse and attenuate incoming sources of daylight and artificial light, and, whenever possible, using a good external display, which should deliver better resolution and contrast.

---

**Hardware quick-fire questions**

**Can I upgrade my 2013, 21.5-inch iMac’s memory?**

The memory in your Mac can be boosted to 16GB, but late 2012, 2013, and Mid 2014 21.5-inch iMacs can only be upgraded by an Apple Store or Authorised Service Provider. Most other models have user-replaceable memory. However, in late 2015 21.5-inch iMacs, it isn’t upgradeable at all.

**Where is my Mac’s hardware UUID?**

Choose the About This Mac command in the  menu, then click the System Report button to open the System Information app. The last item in the app’s right pane shows your Mac’s UUID, which is completely different from its serial number. You can select and copy it from this window.
Is my Mac’s Fusion Drive failing?

Q

My iMac has an Apple Fusion drive, which I’ve checked using DriveDx. The Wear Leveling Count on its SSD part has fallen below 50%, although it’s little more than a year old. Is my SSD failing?

by Richard Champion

A

There are difficulties in estimating the life expectancy of SSDs. The SMART indicator of Wear Leveling Count (173) should indicate lifetime, but some SSDs don’t give accurate values, or they don’t change linearly over time.

Another way to check whether the SSD is wearing out is to look at the total data written to the SSD, reported in indicator 175 (Host Writes MiB). Convert that figure to terabytes and compare the result with an estimate of total write capacity, obtained by multiplying the SSD capacity in gigabytes by 5000. For example, a 121GB SSD should accommodate over 600TB of data being written to it before write failure starts to become likely.

Apple doesn’t put much trust in third-party monitors such as DriveDx, despite their sophistication and value, preferring its own hardware testing tools and those built in to Apple Diagnostics or Apple Hardware Test. If you experience errors with your SSD, invoke any warranty or AppleCare remaining and hope it results in a replacement.

DriveDx provides detailed insights into SMART status indicators, but interpreting the results in terms of expected lifetime is not so easy.

Can I add an SSD to my Mac mini?

Q

I’ve been given a late 2012 Mac mini Server. Can I replace one of its hard drives with an SSD?

by Charlie Howarth

A

Yes, although doing it yourself is a moderately difficult task as it requires some disassembly, which can prove quite fiddly. You’ll need to remove its memory modules, fan, and Wi-Fi aerial before you reach the first drive. Several online videos demo this, such as bit.ly/2l2rt3T.

You’ll need a 2.5-inch SSD with a SATA-III (6Gbps) connector. The drive doesn’t have a separate sled or mount within the Mac, but takes two small mounting bolts which you must transfer from the side of the old drive. If you don’t fancy doing this yourself, a trained Mac service engineer should be able to do it for you in a few minutes.

Once done, start up the Mac from a USB drive with the Sierra installer on it (apple.co/2laroP0); restoring directly from a backup to the SSD may cause older OS X versions to see it as a broken Fusion Drive, and can brick the SSD, so a fresh install and then restoring files from backups is best. If you fancy a challenge, the project in MF296 shows how to set up the SSD and hard drive as a Fusion Drive.

Replacing the upper of the two drives in a Mac mini Server is not simple, and requires decent tech skills.

Can my Mac’s Wi-Fi be boosted with an external antenna?

Q

> Macs have internal Wi-Fi antennas, which can’t be enhanced. USB Wi-Fi ports claim to offer better range, but very few of them have Mac drivers. You’re better off using a range extender to improve your network’s reach.

How can I remove a scratch from my iMac’s display?

> Scratch repair kits either have no effect or may even make the mark more noticeable.

If the scratch is bad enough to warrant replacing the glass panel, it’ll cost upwards of £80 to do so, or even more if you get it done through Apple.

How to stop my iMac’s Thunderbolt cable wiggling?

> iMacs have a design shortcoming in aligning these ports vertically. Some cables fit more snugly than others, but supporting the cable is the only way to stop it from moving if knocked.
macOS

Shine a spotlight on sagacious solutions to your most maddening Mac maladies

macOS quick-fire questions

Why can’t my UPS shut down my MacBook Pro?
> In the Energy Saver pane, an uninterruptible power supply connected using USB can be set to shut down a desktop Mac automatically after mains power outage. macOS doesn’t support automatic shutdown of MacBooks in the same situation, as they can switch to their internal battery for power.

How can I check for old extensions?
> You can look in the Extensions folders in /System/Library and /Library, but it’s much better to make use of the System Information app: click Extensions in the left pane, click the ‘Obtained from’ heading to group third-party items, and then check dates and other details of the non-Apple items.

There’s a file missing from my backup

Q When I deleted a column in an important Numbers spreadsheet by mistake, I went to Time Machine to find a backup. I stepped back a month to when I know it was last correct, but couldn’t find the file there. More recently it has been saved to iCloud, but I can’t find any older versions there. How can I get my old version of the spreadsheet back?

A In Numbers, open the copy of the document that’s now stored in iCloud, then choose File > Revert To > Browse All Versions – and don’t worry; the objective here isn’t to roll back the whole document to an older version.

The app’s interface will switch to a Time Machine-like interface, with the document’s current version on the left and previous ones on the right. You should find that when you moved the document to iCloud, its version history was carried over, too; go back through the versions on the right to the time when the column would have been in the document.

Click the window on the right side to take a closer look at its contents. If you can find a version that contains the now-absent column, interact with Numbers’ window here just as you would on the desktop; click the table, then click the header of the column you want and press +C to copy it to the Clipboard. Next, click the window for the current version, add a new column – without the menu bar available, you can do this by selecting another column and pressing +’ to add one to the right of it – then select the new column and press +V to paste the Clipboard’s contents over it.
In macOS Sierra, I have set up substitutions in the Text tab of System Preferences’ Keyboard pane, which correct most of my common errors, such as typing ‘hte’ instead of ‘the’. Some of them only work for a day or so before they become disabled, and I have to enter them again. What am I doing wrong?

These aren’t stored in a Preferences file, but in your user dictionary, which is a closed database. You can save them all to a file by selecting all and dragging them to a folder in Finder. You could quickly add them back by dragging and dropping that file into the shortcuts list, but that is unlikely to make them ‘stick’.

One potential issue that could be causing those settings to change is use of a third-party app that also performs text substitution or similar functions. If you’re certain that you have no such conflicting software installed and running in the background, the best thing to try is to remove all text substitutions and then leave the Keyboard pane. Open it again, and add the substitutions you want. That should flush out the problem.

Where have power management settings gone?

They’ve moved around in minor Sierra updates. As of 10.12.3, active settings are in /Library/Preferences/com.apple.PowerManagement.[UUID].plist – [UUID] is unique to your Mac, and listed under Power in System Information.

Can I run Sierra on a 2008 MacBook?

The App Store might offer it, but your Mac won’t install it. There’s an unofficial patch to force it (bit.ly/2kZzDgK), but due to Sierra’s lack of support for some old components, we don’t recommend using it.

Documents is missing from my sidebar

The Documents folder in my Finder’s sidebar suddenly disappeared. It’s still selected in Finder’s preferences, and I’ve restarted my Mac. How can I put the folder back in the sidebar?

First check that your Documents folder is still where it should be: switch to Finder and then press 0 + H + H; if it has inadvertently been moved or renamed somehow, you’ll need to put it back at the top level of your Home folder and correct its name. Or, if you’ve used Sierra’s option of putting the Desktop and Documents folders in iCloud Drive, in which case the two folders should be at the top level of that instead.

This whole problem may have arisen because the file that contains Finder’s preferences has become corrupted. Switch to Finder, hold ⌘ and choose Go > Library, and then look in the Preferences folder there for a file named com.apple.finder.plist - move it to another location, perhaps inside your Documents folder, then log out of your user account and back in again, or restart your Mac. Afterwards, you’ll need to set up all of your Finder preferences from scratch, but you may find the Documents folder appears properly in the sidebar again.

One final trick which may be worth trying is starting up in Safe mode (see bit.ly/2kZtUFq). This flushes many system caches, and if nothing else has helped, it may get the Finder’s sidebar working properly again.
iOS Software

Swipe away your touchscreen troubles and rekindle your love of Apple’s mobile devices

iOS software quick-fire questions

Q When should I use VPN on my iPad? A Virtual private networking uses an encrypted connection, which is important, if not essential, when using a public Wi-Fi network. Although the HTTPS protocol used on the internet is still secure, plain HTTP connections could readily be intercepted by others, enabling viewing of sensitive information going between your device and the internet; you’ll find a tutorial in MF310.

I want to be able to translate some French words A In Settings > General > Dictionary, enable iOS’s French-English dictionary. With that done, when you want to translate a word from French to English, select the whole word and then tap Look Up in the bar that appears.

Why does AirPlay Mirroring drop out?

Q My iPhone 7 Plus keeps dropping out when trying to use AirPlay Mirroring. I have a BT Infinity internet connection, have updated to the latest versions of iOS and tvOS, turned off background app refresh, and tried resetting the Apple TV and iPhone. How can I stop these annoying dropouts? A First determine whether this only affects incoming content from the internet, or all content streamed to your Apple TV. If it doesn’t affect locally-stored content, then it’s probably an issue with your internet connection, which may prove hard to fix. BT Infinity should have ample bandwidth, but there may be technical reasons for periodic dropouts that only BT can remedy.

If this is a local problem, work through Apple’s recommended setup for your wireless router, detailed at apple.co/2l4SLWr. Because some routers can encounter issues when routing between local wired and wireless connections, it can sometimes help to use a wireless connection between your Apple TV and your router; other routers may work better on a wired Ethernet connection.

Wireless interference is another possible cause, and Apple has helpful suggestions for dealing with that at apple.co/2i4SLWr. Ofcom’s Wi-Fi Checker app (free, apple.co/2kZNyTT) can also be helpful.

It may be beneficial to explicitly separate your Apple TV and iPhone onto your 5GHz network

Ofcom’s free Wi-Fi Checker app may not detect dropouts, but is a useful initial test for most Wi-Fi network problems.

Sometimes separating out your Wi-Fi connections can be beneficial. Name your 2.4 and 5GHz networks differently; put your Apple TV and iPhone on the latter, and other devices on the former. Even then, you may need to wait for a software update for a complete fix.
The home of technology

techradar.com
Back Issues 
Collect them all

Missed an issue?
Complete your collection of the UK’s No.1 magazine for Apple fans

IN PRINT

ISSUE 310
MARCH 2017
> Become a Mac Genius
> Multi-monitor setups made easy
> Get smart: automate your home
> Use an old Mac as a Time Capsule

ISSUE 309
FEBRUARY 2017
> Get more from Apple Music
> Make your MacBook last longer
> Discover the full power of 3D Touch
> Create your own typeface

ISSUE 308
JANUARY 2017
> Amazing macOS timesavers
> Go pro with your iPhone and iPad
> Smart devices to keep luggage safe
> Learn to paint on your iPad

To order back issues of the print magazine, go to bit.ly/macformat_back or phone +44 (0)844 848 2852 and we’ll post them out to you.

Download back issues onto your iOS device at any time and keep them forever in your personal library. bit.ly/macformatipad

GET 3 ISSUES FOR £5! SUBSCRIBE TODAY!

IN PRINT & ON iOS
> Our print and digital bundle gets you the real magazine and our brand-new digital edition for iPad and iPhone. myfavouritemagazines.co.uk/macformat

ON YOUR MAC
> Read on the big screen, too! If you prefer to read MacFormat magazine on a Mac, then subscribe with Zinio at zinio.com/macformat

76 | MACFORMAT | APRIL 2017
macformat.com @macformat
What’s inside

78-79 REDUCE A MAC’S STARTUP TIME

› A software-only look into what’s slowing down an ageing Mac

80 LEARN ABOUT CLEANMYYMAC 3

› Discover the features that can save you time when cleaning out cruft

Contact us

› Email your queries and your questions to lovemac@macformat.com

› Keep up to date by following us on Twitter @macformat

› Join the conversation at facebook.com/macformat

› Get the latest subscription offers at macformat.com

LOVE YOUR MAC

EDITED BY LUIS VILLAZON

Mac mini late 2012

Most of my writing’s done on a Late 2012 Mac mini. I originally bought it because I was tired of having to replace an entire iMac just because I wanted to upgrade the CPU or graphics card. The plan was that I’d hook up a mini to a 27-inch Thunderbolt display and then I could just replace the mini every few years without throwing away a perfectly good screen each time. Four years on and arguably I’m overdue for an upgrade, but, before I do that, I might as well see if there are any easy ways to tune up the old mini first. Specifically, I want it to start faster; five-and-a-half minutes is just unacceptable! And since this Mac is on its way to retirement, I don’t want to buy hardware upgrades; I’m not going to just SSD my way out of this one. I want to know what app, widget or extension is making it so slow, and fix it.

CLASSIC APPLE KIT FROM 1994!

› The Quadra 630 DOS Compatible was a Mac with a PC stuck inside it. The Mac half was based on the LC 630, using a 33MHz CPU, and the PC part was an expansion card with an Intel 486 chip on it and a single memory socket. They shared a graphics card, and you could start up in either System 7.5 or Windows 3.1. In the mid-1990s, a surprising number of people found this attractive, despite both computers being fairly underpowered.
Racing mini

Streamline a Mac mini to make it start up faster

What is NVRAM?
> Non-volatile RAM (or Parameter RAM on older Macs) stores the settings for screen resolution, speaker volume, startup disk, and some log files from recent kernel panics. To reset it, follow the instructions at apple.co/2kW0l9H.

Will running the maintenance scripts help?
> OS X should run its built-in maintenance scripts between 3:15am and 5:00am, every day, week and month, to clear out old log files and rebuild databases. If your Mac is asleep when the schedule rolls around, the scripts will run when the Mac next wakes up, but if your Mac is always turned off overnight, these scripts might never run.

You can trigger them manually in Terminal by entering `sudo periodic all`. This took about 30 seconds off my Mac’s startup time.

You can’t improve something if you can’t measure it, so my first step was to time my mini as it started up. From the initial startup chime to the login window took one minute and 30 seconds. Once I entered my password, I watched the desktop like a hawk and clicked Safari as soon as it appeared in the Dock. It took one minute and 50 seconds for a blank browser page to open and another 26 seconds for my home page (google.co.uk) to load. So that’s two minutes and 16 seconds from login to a working browser.

Finally, I clicked the Dropbox icon on the menu bar and timed how long it took for the service to start up and confirm that all my files are synced. I use Dropbox for all my work files, to make sure I can write articles even when I am away from home. That means that I need to wait for Dropbox to start before I can do anything useful. The time from logging in to Dropbox giving me the green light, was a whopping five minutes and 25 seconds. These are my baseline times. Next, I set about seeing what I could do to improve them.

Speed superstitions
First, I tried a couple of things that regularly get suggested on the forums. When the 10.10.3 update for Yosemite was released, a lot of people noticed that startup times increased, and one solution was to reselect the startup disk in System Preferences. This made no difference in my case, which didn’t surprise me in the least, but it’s still good to be objective.
about these things. Equally, there was no obvious reason why resetting the NVRAM would help either, but I did it anyway. Surprisingly, the time from login to opening Safari did drop by 40 seconds but the next day, starting up from cold, the times had returned to something very close to the baseline values. It’s possible that data stored in NVRAM slows OS X down, but if it rewrites this information every time you clear it, that isn’t much help.

Next I tried a commercial cleanup utility, CleanMyMac 3 (£34.95, macpaw.com) claims to have “powerful scanning that digs up all the junk” and “tools for speeding up your Mac”. It took about half an hour to sift through my 500GB hard disk and find 27GB of junk files that it pronounced ‘safe to delete’. So I deleted them. The time from the startup chime to login screen: exactly the same. The time from login to the Google home page in Safari: 52s slower. Time from login to Dropbox starting: also unchanged. From this I conclude that some of those ‘junk’ files, though safe to delete, actually contained cached data that was doing something useful. Sure enough, when I ran CleanMyMac3 again straightaway, 135MB of junk files had magically reappeared - presumably the cache files that had been recreated. I had still saved quite a bit of disk space by dumping the other 26.9GB of junk files, but it wasn’t making my Mac any faster.

**Lightening the load**

Next came a brutal round of uninstalling apps. Of the exactly 100 apps installed on my mini, I threw out 67 of them. Anything I hadn’t used recently, or didn’t have a specific use for, got thrown on the bonfire. There was no “that might come in handy one day” or “dunno what that is, better leave it”. If I change my mind and want something back later, it’s easy enough to download it again. This freed up another 23GB of disk space, but even better, it gave me a slight speed boost. The time from logging in to opening Safari actually dropped by over 40 seconds, which must be because some of those uninstalled apps had been

---

An appealing attribute of the Mac mini is that you can upgrade to a new model with less waste overall than an all-in-one iMac.

---

It’s amazing how much debris accumulates on a hard drive in just four years.
HOW TO Spring-clean with CleanMyMac3

1 System junk
Many apps have their own databases, cache files, thumbnail images, or log files detailing the results of each software update. For apps you use often, these are usually to improve performance; if you have many you rarely touch, cruft can build up. The Smart Cleanup feature only locates files that are safe to remove.

2 Old, unused apps
Mac apps can often be uninstalled by dragging their icon from Applications to the Trash, but there are awkward ones that will leave some crumbs behind. Once an app’s been trashed, it can be hard to track these files down or work out what they belonged to. CleanMyMac3 does a good job of completely uninstalling apps.

3 Wayward widgets
The list of extensions loaded when you log in is surprisingly large - more so than the Users & Groups pane lets on. It isn’t obvious how to even find them, never mind how to safely remove them. The Extensions scanner tells you what each belongs to, and what it does, so you can make a more informed decision.

Heavy cloud
The final task was to do something about the Dropbox startup time. Clicking on its menu bar icon reveals it spends the most time ‘Starting’, then ‘Indexing’ and ‘Syncing’. It seems to index and sync even if no files have changed since the last time, so this must also include the time taken to scan each file and see if they do in fact need to be indexed and synced at all.

Dropbox's folder contained 20 years of writing – more than 17,000 files, using 3.25GB. Clearing out the stuff for mags I don’t write for any more plus articles over a year old pruned it by 2GB and over 13,000 files. These older files can go in cloud storage elsewhere to keep them accessible, but it needn’t be a service that continuously syncs with all my devices. On the next restart, Dropbox took 22 minutes to reindex and sync one final time. After that, it dropped below three minutes.

Total startup time – from power-on to all kernel extensions running – has gone from five minutes and 25 seconds to three minutes. Disk space is up 52GB, so backups will be quicker. Best of all, no hardware changes were needed. And the two-and-a-half minutes saved each morning might just let me put up with another year out of this Mac before I finally replace it.

Luis systematically tries every operating system from Lion to Sierra to find out which works best on his wife’s 2010 MacBook Air.
Subscribe wherever you live...

› Never miss an issue again
› Every issue delivered to your door at a fraction of the price
› Get instant access to the magazine on your iOS devices
› Huge savings and the best value for money

Subscribe from as little as €29/$42
and get MacFormat wherever you are!

It’s easy to subscribe... visit
myfavouritemagazines.co.uk/MACsubs
Apple gear for 2017

Written by Alex Blake

From new iMacs to the ‘iPhone X’, 2017 could be a huge year for Apple. Here’s all the new kit that’s just over the horizon behind it and have a solid 2017. To do that, it needs to release some pretty special products. Here’s what we think we’ll see.

Return of the Mac Pro?
Apple’s last update to the iMac came in late 2015, but don’t expect a major overhaul in 2017. While updates are expected to the iMac lineup, all talk is of ‘minor bumps’ rather than anything truly drastic.

For one thing, expect USB-C ports to make their way to Apple’s desktop system, along with support for Thunderbolt 3. The graphics chips are also widely said to be facing an update, bumping up from the choice of AMD R9 M380, M390 or M395 chips (although these discrete cards are only available in the 5K iMac).

Interestingly, it was reported in late 2016 that eagle-eyed users had found code in a macOS 10.12.2 beta that made references to three graphics cards – named ‘Polaris 10XT2’, ‘Polaris 12’ and ‘Vega 10’ – that are not

Apple is known for running a notoriously tight ship, and it’s a rare leak indeed that escapes its sleek, svelte glass walls. That’s not to say leaks do not exist, of course. Just as well, because it lets us take a look at what we can expect Tim Cook and friends to unleash upon the world in the upcoming year.

Depending on your perspective, 2016 was either a big step forward for Apple or a huge disappointment. The iPhone 7 got a load of performance boosts and an amazing dual camera setup for the 7 Plus, but ditched the headphone jack, to much consternation. We got shiny new MacBook Pros with the flexible, functional Touch Bar, but many users felt let down by the so-so spec updates. And then there was the Watch Series 2, which still hasn’t lit the world on fire.

Apple needs to put that divisive year

NEW!
Currently present in any iMac, Polaris 10XT2 is simple enough – it could be an improved version of the Polaris 10 chips currently in iMacs. It is not clear what the Polaris 12 is a reference to, though. Tantalisingly, the Vega 10 snippet could be a reference to updated Mac Pro video chips. Vega is AMD’s high-end chip architecture, which, if it ended up anywhere, would logically make its way into the Mac Pro. Yes, the very same Mac Pro that Apple has not updated for several years. Now that the software support is there, all that we’re waiting for is supported hardware to make its way into Apple’s desktop Macs, be they Mac Pros or otherwise.

We’re certain the MacBook range will also be refreshed, but again we’re looking at minor bumps in performance here and there. It’s likely we’ll see improved processors in the MacBook Pro, with Apple transitioning to Intel’s Kaby Lake CPUs from the current Skylake processors; the 12-inch MacBook might also see CPU improvements.

It’s also interesting to note that Bloomberg has reported that “some Apple engineers wanted to add a Touch ID fingerprint scanner and a second USB-C port” to the 12-inch MacBook in 2016; it’s possible that these features could make their way into a 2017 update instead. The addition of Touch ID alone would be a great little boost, in our opinion.

The addition of Touch ID to MacBooks would be a great little boost, in our opinion

This year could see a refresh of the Mac Pro after years without an update.

7s and even iPhone X (for the iPhone’s tenth birthday), but the consensus seems to rest on iPhone 8. We’ll stick with that.

In practical terms, there’s a lot to get excited about. As we covered in Apple Rumour, most of the talk is that Apple will go for an iPhone with an edge-to-edge, OLED display, and may even incorporate curved sides in the vein of Samsung’s S7 Edge. That latter concept gained some momentum in January 2017 when screen maker Japan Display confirmed that it is ready to begin making curved displays. While the company didn’t explicitly mention that it would do so for Apple, it did state that it was building the screens for its hardware partners. Tim Cook’s firm is one of its customers, so people have since joined the dots on that idea.

Of course, having a display with curved edges necessitates the removal of the iPhone’s bezels, at least on the sides. But the talk is that
Apple will remove all bezels in at least one 2017 iPhone model, instead having a screen that stretches from top to bottom and side to side.

That would lead to a virtual Home button built into the display - a natural next step from the iPhone 7's Home button (which isn't a moving button but instead utilises a Taptic Engine to mimic a physical button press). Apple has a patent (filed in 2014) for a 'capacitive fingerprint sensor' that would supposedly allow the Touch ID sensor to move away from the Home button and be placed anywhere under the screen - useful if you're looking to eliminate the Home button itself.

As for an OLED display, rumours that Apple is working on the tech have been around for years. OLED displays have better contrast and are more power efficient than their LCD equivalents (as found in current iPhones), but are also expensive. With the iPhone's tenth anniversary coming in 2017, many analysts have suggested Apple will release a high end iPhone to mark the occasion - the 'iPhone Pro' that failed to appear last year - alongside non-OLED updates to the iPhone 7 and 7 Plus. The improvements will come with a sizeable premium, and analysts are pegging the next iPhone price tag at over $1,000.

But we'll leave the best till last - wireless charging. This was the most requested feature in the next iPhone according to MacFormat readers, and could well make it into the iPhone 8. For one thing, wireless charging company Energous has been developing long range wireless charging tech supposedly able to charge devices up to 18 feet away. When quizzed on the eve of CES 2017, Energous CEO Steve Rizzone declined to comment on who the firm was working with, but said: “I can virtually guarantee that you

The iPhone X could look very different to previous iPhones, with an all-glass front; bezels and physical buttons would be banished.

What does the Team want from Apple in 2017?

Graham Barlow
Editor-in-Chief
Was the introduction of the Touch Bar to the MacBook Pro line-up a tacit indication of the enthusiasm for a touchscreen Mac? I think there's still demand for it from people like me, who don't mind a screen full of smudgy fingerprints, and just want to banish the keyboard from our desks.

Alan Stonebridge
Production Editor
It would be great if the Touch ID feature could make its way to the MacBook range. Although processors will almost certainly be upgraded, I doubt we'll see major performance boosts here, so incorporating Touch ID into the more affordable laptops would appeal to many.

Alex Blake
Commissioning Editor
While I secretly want to see the Mac Pro make a triumphant return, I'm skeptical over whether it will happen. An anniversary iPhone is more likely in my opinion - Apple will want to blow its rivals out of the water with something truly special after a decade of smartphone supremacy.

Paul Blachford
Art Editor
The current iMac design has been with us for a long time. Microsoft's Surface Studio Pro is a shot across Apple's bows in the all-in-one desktop space; sure it's pricey, but it shows some clever takes on what a more Creative proposition could offer. Let's hope we see a new iMac in 2017.
The Touch Bar would be a great addition to Apple's wireless keyboard.

have products from this company on your person, sitting on your desk, or at home”.

Fuelling speculation of an Apple connection was Dialog Semiconductor’s recent takeover of Energous. Apple is Dialog’s largest customer, reportedly contributing up to 70% of its revenues. Energous has previously mentioned that “most, if not all, of Energous’ early adopters are existing Dialog customers”, so it’s feasible that that could include one of the most useful parts of the Touch Bar is the integrated Touch ID button, which makes logging in and paying for things online quick and simple. Apple would need to integrate a Secure Element into a wireless Touch ID keyboard to protect your fingerprint, but has had success with biometric validation over a wireless signal, as you can pay for purchases on your iMac using the Touch ID feature on your iPhone. A Touch Bar of genius

According to Bloomberg, Apple is looking into standalone Touch Bar keyboards and will decide whether to release them based on how well Touch ID and the Touch Bar do on the new MacBook Pro. We’ve found fingers in pies, and all that.

A Magic Keyboard with Touch ID is a possibility, if battery drain can be overcome

Apple. And, as a final hint, it was reported in February that Apple had joined the Wireless Power Consortium, the group behind the Qi wireless charging standard. Fingers in pies, and all that.

A Touch Bar of genius

According to Bloomberg, Apple is looking into standalone Touch Bar keyboards and will decide whether to release them based on how well Touch ID and the Touch Bar do on the new MacBook Pro. We’ve found one of the most useful parts of the Touch Bar is the integrated Touch ID button, which makes logging in and paying for things online quick and simple. Apple would need to integrate a Secure Element into a wireless Touch ID keyboard to protect your fingerprint, but has had success with biometric validation over a wireless signal, as you can pay for purchases on your iMac using the Touch ID feature on your iPhone.

One the one hand, a wireless Touch ID keyboard would make sense, allowing you to quickly log in or pay for purchases with barely a movement of your finger. On the other, it could result in you activating Touch ID without meaning to (especially on the Magic Mouse, where there is little space for such a button). We feel a Magic Keyboard with Touch ID is still a possibility, provided Apple can find a way to overcome the battery drain a Touch ID bar would cause – an OLED stripe like that of the MacBook Pro would require a fair amount of power.

Go Pro

After introducing the 9.7-inch iPad Pro in 2016, Apple may well bring forth another new iPad Pro with a 10.5-inch model, aimed at education and business buyers. According to reputed Apple analyst Ming-Chi Kuo, the 10.5-inch model will be positioned as a mid-range option, with the 9.7-inch iPad Pro becoming the lower tier option and 12.9-inch version remaining Apple’s top tier offering.

That could mean either the iPad mini or the iPad Air line gets phased out altogether. Given that the latest iPad Air

5 rumoured things Apple definitely won’t do in 2017

1 A new iPad Air

Apple may update the iPad Pro in 2017, but don’t hang your hopes on a new iPad Air. Apple hasn’t updated the Air since 2014, and it’s likely being superseded by the iPad Pro and iPad mini ranges.

2 Facial recognition

In February 2017 Apple bought Israeli firm RealFace, which specialises in facial recognition. There is talk that Apple will bring this tech to future iPhones, but we think it’s too late for the 2017 edition.

3 Virtual reality

With rivals Google and Microsoft exploring virtual reality, some pundits have been hankering for Apple to join the fray. While Apple might be interested, it’s too soon for a 2017 launch.

4 Electric Apple Car

‘Project Titan’ has gone quiet. With rumours swirling that Apple’s focus has shifted onto in-car entertainment or away from cars altogether, it could be a while before we see any more on this.

5 Hollywood studio

Kim Dotcom of Megaupload infamy has claimed that Apple will purchase a Hollywood movie studio (perhaps Time Warner) to further its original content plans. We’re not convinced yet...
came out in 2014 and the newest iPad mini launched in 2015, it’s more likely to be the Air that gets discontinued.

Regardless, Kuo claims that the 10.5-inch and existing 12.9-inch iPad Pro models will be updated with new A10X processors, while the 9.7-inch version would come with the A9X chip.

In terms of design features, we expect to see thinner bezels and slightly larger screens, while maintaining the same physical dimensions as in earlier models. There’s also a possibility that the Apple Pencil will stick to the side of the new iPads using magnets – a handy addition, though not exactly groundbreaking.

Music to our ears
Predicting hardware is difficult, but there is one obvious trend with Apple software: Apple Music will get bigger and better. In 2016 it doubled its subscriber base from 10 million to 20 million. While that pales in comparison to Spotify’s 40 million paid subscribers, it’s still huge growth and will be a key revenue stream for Apple this year. After all, 20 million people paying £10 a month is a lot of money.

Apple also tried its hand at original video content in 2016, producing Dr Dre’s six-episode Vital Signs series, and has purchased the rights to James Corden’s Carpool Karaoke. In an interview with Variety, Jimmy Iovine indicated that forthcoming original content such as this would be exclusive to Apple Music: “We’re trying to make the music service a cultural point of reference, and that’s why we’re making video. We’re making video for our Apple Music customers and our future customers,” he said.

In fact, Tim Cook made it explicit that original content will be a key part of Apple Music’s output in 2017. During an earnings call on 31st January of this year, he told investors: “In terms of original content, we’ve put our toe in the water doing some original content for Apple Music, and that will be rolling out throughout the year. We’re learning from that, and we’ll go from there.” Keep your eyes peeled, then.

However, Iovine has made it very clear that Apple Music will not look to imitate or compete with Netflix. “It’s Apple Music, and it happens to have video and audio... It has nothing to do with what Netflix is doing,” he told Variety.

We can expect Apple Music to grow and expand in big ways, then, and the same goes for the iPhone. While we may not see everything discussed here make it into the device, Apple is surely planning something big for the iPhone’s tenth birthday bash. This could be a big year.

Elsewhere, Apple’s hardware offerings will change in more subtle ways. Better graphics and longer lasting batteries are the order of the day – but make sure to keep an eye out for the return of the Mac Pro. It’s unlikely, we know, but what’s the harm in dreaming?
ON SALE NOW!

Available at WHSmith, MYFAVOURITEMAGAZINES.CO.UK or simply search for Mobile Choice in your device’s app store
Awarded to a five-star product we believe is truly exceptional in its category. Given solely at the discretion of the Editor.

Given to a hardware or software product that might not be the very best in its category, but is noted for affordability.

Our group test winner gets this award for being the best of its kind when pitted against other comparable products.
GoPro Hero5 Black

Hugely powerful, but not without its flaws

Reviewed by LEON POULTNEY

£349 FROM GoPro, gopro.com FEATURES 4K video capture at 30fps, 2.0-inch touchscreen, 12MP still images, waterproof up to 10m, USB-C port

GoPro has finally made its famous action cameras a bit more user friendly. In this instance, the new additions include a rear touchscreen display, voice activation and easy one-button control, while the overall shooting experience has been abridged to make capturing the action as painless as possible.

Video resolution sits at 4K at 30fps; you get 12MP still images, and if slow motion is your thing you’ll be able to enjoy 1080p resolution at 120fps. Stills can be taken in single, burst and timelapse modes, and saved as raw files for post-production tinkering. In addition, a new WDR (Wide Dynamic Range) mode, which is GoPro’s version of High Dynamic Range (HDR), makes shooting perfectly exposed still images much easier.

The two-inch touchscreen is bright and easy to see, while a smaller screen at the front gives readouts on the shooting mode, SD card space and battery. There’s also a large red button on the top of the camera, which GoPro refers to as its One-Button Control. Press this rubbery square and the camera powers on and immediately starts recording.

The Hero5 Black features 4K video resolution at 30fps.

The Hero5 Black is waterproof up to 33ft (10m) out of the box, no case required, but the absence of a case makes it feel a little exposed.

The small lens cover on the front of the camera is now removable, as GoPro offers a range of filters to boost footage captured when diving or snorkelling. You simply twist to remove the cover and snap on a filter; it’s also handy if the cover gets damaged.

Testing the water

The lack of a plastic casing greatly improves the exterior styling, and it also means that sound quality is now unobstructed. A Super Suit is available if you wish to take your camera deeper than 10m, but we’d suggest using it for any rigorous underwater activities, as we found that the wet stuff can penetrate the removable lens cover seal.

In fact, the camera feels a little naked without the tough plastic casing of old, but it does make access to the touchscreen nice and easy, while the buttons are just a prod away. It’s a sturdy housing, surviving bumps, drops and being submerged in water many times.

The only issue we found is with that removable lens casing, which caused a small...
GoPro Hero5 Black

APPLE CHOICE

GoPro had to step up its game, and this is a great reminder of why the name is so revered among action cam fans.

SPECIFICATIONS
- Improved video and image quality
- Excellent apps
- Voice controls
- Doesn’t feel as sturdy without a case

VERDICT

APRIL 2017 | MACFORMAT | 91

SATISFYING CHOICE

ALTERNATIVE CHOICES

Sony FDR-X1000V
£349

SPECIFICATIONS
- FROM sony.co.uk
- 8.8MP still images
- 4K video footage at 30fps
- Waterproof to 10m (with included case)

GoPro has revised its Capture app, which makes it easier to pair the camera to an iPhone over Wi-Fi and review footage. The pairing process is still a bit of a faff, but the app is intuitive and simple to use.

Editing is taken care of by two new iOS apps: Splice and Quik. The former gives you greater control over edits, and enables access to the iTunes library for overlaying proper music. Quik’s desktop app is the most powerful editing tool that GoPro offers; you can overlay data captured from the built-in GPS technology for extreme analysis of speed, G-force and other data fields, as well as giving greater control over the editing process.

Those apps, plus the fantastic 4K video quality, great range of shooting options and improved usability make the Hero5 Black a brilliant action cam. It has its issues, not least the lack of a case, but it’s still a brilliant addition to any videographer’s kitbag.

amount of water leakage for us, which in turn created some steaming in underwater shots.

Still, the Hero5 Black is very simple to set up and use - the rear touchscreen means your iPhone isn’t required for this process. You just swipe to change settings, although this can be a bit tricky when the device is wet (although you can control it with your voice).

App attack
Advanced users can fine-tune exposure with a new Exposure Control setting, as well as adjusting ISO, sharpness and EV comp through the ProTune settings. The sheer weight of options can be baffling, but it won’t take much trial and error to get things right.

The built-in spot metering is good, while the new Electronic Image Stabilisation is a huge boost for this camera, as it creates much smoother footage without inducing motion sickness. It drains the battery, though.

GoPro has updated its hero range to improve usability, with a large touchscreen on the rear of the Hero5 Black.

Garmin Virb Ultra 30
£327

SPECIFICATIONS
- FROM garmin.com
- 12MP still images
- 4K video footage at 30fps
- Waterproof to 40m
(with included case)
**The Headphone**

**Tuneful wireless earphones**

These earphones are so light and snug that you soon forget they’re there. They offer Bragi’s Audio Transparency, which filters the ambient noise of the city and places the music as a backdrop – or you can stick with regular full fat sound.

As these are wireless and the fit is so good, they’re very liberating. Removing your jumper is now issue-free, unlike wearing wired alternatives, which can leave you horribly entangled.

The controls are simple: three buttons on the right earbud that cover Bluetooth, power, volume, skip a track, queue up Siri. The looks are simple and non flashy, too – with the right hat on, no one can tell you have them in at all. In addition, they use the intricate architecture of the ear to hold them in place, making them feel comfortable and secure.

The audio stops when you remove the right earbud (and restarts when you put it back), but we had issues with them restarting the music (and draining the battery) when not in our ears.

Battery life is good, sound quality is great and the earbuds are unobtrusive. Admittedly, they are expensive, but if you’re happy to pay the price you will not be disappointed. Though you may stumble over that awkward name…

**SIMON KIRKANE**

---

**Game Capture HD 60S**

**Boost your game broadcasts**

The HD60 S looks and works almost exactly like its HD60 predecessor. It takes an HDMI input from a game console, for example, passes it through to a TV, with no latency that we could detect, and also over USB to its app on your Mac, where you can record it, or broadcast live – with optional overlays and a voiceover – to places like Twitch and Ustream.

Its key feature is Instant Gameview, which reduces the latency seen in the preview on your Mac from the two to three seconds you get with previous models to a tiny duration – not so you can play on your Mac’s screen, but to make life easier and your broadcasts potentially more professional; trigger an overlay on the live feed, say, while juggling an ongoing game and your attention is only diverted for as long as it takes to glance at your Mac.

The need for a fourth-gen or better Core i5 processor and an AMD or Nvidia GPU may exclude your Mac from compatibility; it worked well on our MacBook Pro (with a 2.7GHz Core i7 and Radeon Pro 460), though even that couldn’t deal with the app’s (optional) 60fps preview. The frame rate on recordings and our TV is unaffected by this.

Ultimately, the preview’s tiny delay makes the HD60 S a good tool if you’re serious about showing off gaming and broadcasting skills.

**ALAN STONEBRIDGE**
Wacom Intuos 3D
The tablet giant introduces an interesting new format

Reviewed by Rob Redman

£180 FROM Wacom, wacom.com
FEATURES Multi-touch, 21.6x13.5cm active area, Intuos pen included, 480g

When it comes to Wacom products, you expect a high end feel. Unfortunately, the Intuos 3D doesn’t quite live up to other members of the family. It looks great, with pleasing shapes, thin enough to be comfortable and with some useful buttons, but the plastics used are hard and brittle feeling, rather than the more commonly used soft-touch materials Wacom is known for. Everything feels a little cheap, including the stylus and tablet buttons.

However, the interactions with the tablet are very positive and feel good in extended use; that’s important, as this kind of tool often supersedes the use of a mouse. The button clicks feel responsive and inspire confidence on both tablet and stylus. What’s more, the buttons are programmed out of the box (with ZBrush Core commands), making for less time spent hunting in menus, keeping you creative and efficient. Although, this will be of particular interest to ZBrush newcomers, it’s a handy default for anybody, saving on set-up time when you first install the device.

A pleasing performer
If you travel a lot, you’ll be glad to know that the stylus can be stored in a handy fabric loop at the top of the tablet, and the USB cable can be detached, unlike some other tablets. There is also an option for a wireless kit, which is similar to other Wacom devices, with a small dongle that plugs in unobtrusively. For a little added protection on the move, Wacom also offers fitted cases on its online store.

The most important element of using a device like this is how the nib feels on the tablet’s active surface, and you might expect this to match the hard, brittle feeling elsewhere, but the reality is it’s a pleasant experience. If the stylus had the soft rubber grips of other Wacom styluses this would be a real joy. As it is, drawing and sculpting feels good. The nib runs smoothly over the surface and is also replaceable, although not with the variety of nib types that the Intuos Pro offers. You may appreciate the grid of dots on the tablet’s active area, but they could prove to be a distraction. Either way, they don’t interfere with the operation at all, so you shouldn’t be overly concerned about them.

Powerful to the core
A big benefit of the Intuos 3D is that it’s essentially a bundle to get you up and running with 3D sculpting as easily as possible. The box comes with a download code for the powerful ZBrushCore from Pixologic, a well-regarded 3D sculpting and painting app, worth $149.95 (about £120).

What’s more, included with the bundle is time-limited access to ZBrush training videos, which will be useful to newcomers who want to explore the possibilities of working in 3D. The overall experience with the Intuos 3D is a good one. The bundle offers fantastic value, but it would be worth considering the device for the tablet alone. The materials don’t replicate the high-end feel we’re used to from Wacom, but you soon forget that and working with it is a lot of fun. We find using a tablet for artwork is more intuitive, healthy and fun than a mouse and keyboard, so the Intuos 3D should be considered if you’re on the hunt for a new input device.
AluCharge
Cut cables and get charging

€59.95 (about £52) FROM Just Mobile, just-mobile.eu
FEATURES 4x 2.4A USB ports (6.2A total output), 10.1x7.3x1.9cm

The problem with being surrounded by tech is the inevitable mass of wires.
If that sounds familiar to you, give AluCharge a look.

It’s a multi-device charger with a wall plug rather than an internal battery. It has four USB ports to charge your devices, so it’s useful if you’re short on free wall plugs (or just want to reduce the number of things you have plugged in).

It’s also handy if you’re travelling. Instead of having to carry several bulky wall plugs, you just need the one for the AluCharge. That’s complemented by its portable shape, so it won’t take much space in your luggage (unlike many multi-device chargers, which have huge footprints).

AluCharge delivers 2.4A to each port, but as a whole the device can output a maximum of 6.2A. That’s enough to simultaneously charge four iPhones or other low power devices, but as an iPad requires 2.4A, you will not be able to charge all your devices at the normal speed if you throw some iPads into the mix. Still, the space you will save by leaving a load of wall plugs at home partially counters this.

A status indicator for each port would have been a nice addition, showing you battery levels for each device at a glance. It’s also very hard to remove cables once they’re plugged in.

Zus Smart Car Charger
A phone charger and car locator

£33 FROM Nonda, nonda.co
FEATURES 2x USB ports (4.8A), Bluetooth, 3.6x1.7x8.5cm

Losing your parked car is never a fun experience. To allay that concern, Nonda thinks it has the solution.

Plug this dongle into your parked car’s cigarette lighter port (with the engine on) and sync it to your iPhone via the Zus app, and its map will guide you back when you need to retrieve your car.

The app has some nifty features. Set up a parking alarm and it’ll buzz you 10 minutes before your time is up. Share your location with select contacts so lift-sharers can find you. The dongle has two built-in USB ports that can charge two iPad Pros simultaneously, should you so desire. It can even monitor your car’s battery health and calculate journey costs.

But do you need it? You can already mark, track and share locations with Maps, and set up parking alerts in Reminders and Siri. Zus gives you the convenience of that bundled into one app, but it won’t work in covered locations like underground and multi-storey car parks, which limits its usefulness.

Indeed, the parts of this device that most appeal to you may be those unrelated to parking – the car battery reports and the extra USB ports. If so, it’s worth your consideration. If not, give it a miss. ALEX BLAKE
Mesh Routers
If you have a large home then you might consider replacing your router with a wireless mesh network of nodes.

BT Whole Home Wi-Fi
Wave goodbye to deadspots

£300 for three pack > FROM BT, bt.com

 FEATURES Dual-band Wi-Fi, 1x Ethernet port per node

Price ★★★★★
Mesh systems are designed for large homes and many of us will be able to make do with a more powerful standard router. But for far less money these BT units are good value, and work with all broadband providers, not just BT.

Performance ★★★★★
With three in a pack, you’d need to have a very large (or tall) home before you ran out of connectivity. Signal remains very strong throughout and you could easily use it to stretch signal to an outbuilding or garage with clever placement (you’re helped with this during setup).

Design ★★★★★
BT’s disc design isn’t ugly, but it’s hardly attractive and you need a reasonably big, flat surface to stick the units on (they’re 16.5cm in diameter). Each disc has a pull-out tab showing you Wi-Fi connection details.

Ease of use ★★★★★
The Whole Home system is configurable via the iOS app or a web-based configuration interface. One clever feature is that you can pause your Wi-Fi at the touch of a button, so you don’t have to deal with each device individually.

Linksys Velop
WiFi that sets you free

£500 for three pack > FROM Linksys, linksys.com

 FEATURES Tri-band Wi-Fi, 2x Ethernet ports per node

Price ★★★★★
Mesh Wi-Fi systems are expensive and the Linksys Velop is no exception, setting you back £500 for a three pack, but it is a very good system. It is also available in a one pack for £200 (not too useful on its own) or two pack for £350.

Performance ★★★★★
The Velop easily blankets a large home with great Wi-Fi signal. We had no issues connecting up devices in a large four-bedroom home and throughput remained strong. We were able to use one Velop to connect our TV and YouView box to Wi-Fi thanks to the dual Ethernet connectivity.

Design ★★★★★
Each Velop node is a vertical block that could easily slot into a bookshelf or on top of a cupboard and the power – and any Ethernet leads – connect to the base. It’s rather aesthetically pleasing and will look good in a home.

Ease of use ★★★★★
Though not designed for those who like to tweak every aspect of their Wi-Fi’s performance, the Velop system is very easy to configure initially and – thanks to its iOS app – no issue to manage on an ongoing basis.

Reviewed by DAN GRABHAM

For the money, it’s hard to ignore the BT Whole Home Wi-Fi system. Not only does it almost set itself up, but connectivity is fast and true.

While the Velop’s performance can’t be questioned, its price point can – other options, are available for significantly less.
Take a look at the Productivity section of the Mac App Store and you’ll see it’s chock full of tools to make you work faster and smarter, and make sure you never forget an appointment again. And that’s not even all of the productivity apps available for macOS – there are plenty more that are not even on the Mac App Store.

So which one to choose? Well, that obviously depends on what you need to do. Is it a simple list creation app you want? Or do you need a fully-featured Getting Things Done (GTD) task manager for serious productivity?

Whatever kind of tool you’re after, there are a few features that you should look for and which are common to all. For one thing, an intuitive interface is critical. One of the biggest reasons most of us don’t use productivity aids, even when we’ve paid for them, is that they get in the way of us working rather than helping us to work. A good user interface will allow you to do what you need to do with only a few clicks, swipes, or taps. No one wants to spend time trawling through menus when you’re meant to be knocking things off your to-do list.

We feel that a shallow learning curve is equally important. You shouldn’t have to spend hours learning how to use a tool that’s supposed to save time and effort.

Perfect productivity

Less critical (but still useful) are functions that allow you to sync data across multiple devices. This is particularly handy if you use the app both on your Mac and on an iPhone or iPad. To hijack an old adage, the best productivity tool is the one you have with you – so having it available on your iPhone is key.

Finally, it’s important that you can quickly add tasks and update them – the faster you can do this, the more likely you are to keep using the app in the future.

We’ve tested each of the six apps here against those criteria. Read on to find out how they fared.

How we tested

We installed each app on a 2013 MacBook Pro running macOS Sierra. We poked around the app’s user interface, evaluated how long it took to learn to use proficiently, and put its syncing tools to work. We also entered the same set of tasks into each one to get an idea of how quick the input process is. We then gave each app a score based on our findings.
Things to consider...
Everything you need to know before getting started

1. **Mac and iOS versions**
   If you have a Mac and an iPhone or iPad, you’ll want to use the app on all your devices. Check whether the iPhone and iPad versions are universal or need to be bought separately.

2. **Teamworking and collaboration**
   In our test, only Wunderlist Pro and ToDo Cloud offer collaborative support tools.

3. **Are you disciplined?**
   Productivity tools are only as good as the information you supply. OmniFocus, Things and ToDo work well when you’re disciplined and work with them every day, adding all your tasks. Clear and Taskpaper, however, are just as effective when used ad hoc.

4. **Beware the price tag**
   Two of the apps, Wunderlist and ToDo, have subscription options; OmniFocus has a Pro upgrade that costs as much as the app itself.

5. **Be prepared to learn**
   As you’ll see from our learning curve test, there’s a variation in how much you need to learn to use each app. Are you prepared to put in the time to get the best out of the one you choose?

6. **Preferred user input method**
   Clear stands out for its use of gestures, while Taskpaper relies more on text/keyboard shortcuts. OmniFocus also uses shortcuts; the others use point-and-click control.
**Test 1 Interface**
Are the apps intuitive?

Clear’s interface is as simple as it gets, while TaskPaper’s simplicity is deceptive because it uses keyboard shortcuts and text to identify tasks, projects and tags – quicker than hunting and pecking but takes some getting used to. Wunderlist, on the other hand, sticks with listing projects and tasks, letting you add notes, for example, in a separate window. It also gives you the option of a picture background, which is a nice feature.

Of the GTD apps, OmniFocus has the edge, while TaskPaper gets a high rating for its speed.

**Test RESULTS**

<table>
<thead>
<tr>
<th></th>
<th>Clear</th>
<th>OmniFocus 2</th>
<th>TaskPaper</th>
<th>Things</th>
<th>ToDo Cloud</th>
<th>Wunderlist</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
</tr>
</tbody>
</table>

**Test 2 Learning curve**
Getting a grip on how they work

Clear has almost no learning curve. Whether you use a trackpad or a mouse, creating lists, adding tasks and moving tasks between lists is easy. Likewise, Wunderlist uses familiar conventions and shortcuts to create lists and tasks. Double-clicking a task enables access to deeper features like adding comments and tags.

TaskPaper’s learning curve is a fairly steep one because its interface is heavily based on keyboard shortcuts and text. Learn those, however, and you’re good to go.

The other three need a little understanding of Getting Things Done concepts to get the most out of them. If you have that, using them at a basic level is straightforward. To get the most from OmniFocus’s power and deep feature set, however, you’ll need to refer to its help documents and videos.

**Test RESULTS**

<table>
<thead>
<tr>
<th></th>
<th>Clear</th>
<th>OmniFocus 2</th>
<th>TaskPaper</th>
<th>Things</th>
<th>ToDo Cloud</th>
<th>Wunderlist</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
</tr>
</tbody>
</table>

**Test 3 Syncing**
Essential for any productivity tool

Clear and Taskpaper use Apple’s iCloud syncing to synchronise data between devices. Clear has an iOS version as well as its Mac client, so syncing between the two (once you’ve set them up) is as fast as Apple’s servers allow. Taskpaper has no iOS version, but its files are stored in iCloud Drive and can be read by compatible third-party apps.

The other four all have their own servers for syncing. The downside is you need to create an account to use them. The upside is that, in the case of ToDo and Wunderlist, you can log in to your account from a web browser and use it as if you were running the app – handy if you need to log in from work.

In all cases, we found syncing worked well. Wunderlist was particularly impressive for the speedy times in which it propagated additions to different devices.

**Test RESULTS**

<table>
<thead>
<tr>
<th></th>
<th>Clear</th>
<th>OmniFocus 2</th>
<th>TaskPaper</th>
<th>Things</th>
<th>ToDo Cloud</th>
<th>Wunderlist</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
</tr>
</tbody>
</table>

**Test 4 Quick entry**
Get started in a hurry

The ability to quickly scribble down tasks is crucial to any productivity tool. The best ones let you bypass the interface and get straight to work.

In the case of Clear, quick entry is what the app is made for, and adding items to a list couldn’t be quicker or simpler. And, once you’ve mastered Taskpaper’s text commands, it takes seconds to add new tasks.

Things has a Quick Entry option but, frustratingly, it must be selected from a dropdown menu – there’s no keyboard shortcut, which negates the benefit somewhat. In Wunderlist and ToDo, you click on the Inbox in the sidebar and start typing to create a new entry and hit Return to finish.

OmniFocus goes one stage better. Hit +N in the inbox and type the entry, then tab and type in the project, context and date fields, typing and selecting from prompts as you go.

**Test RESULTS**

<table>
<thead>
<tr>
<th></th>
<th>Clear</th>
<th>OmniFocus 2</th>
<th>TaskPaper</th>
<th>Things</th>
<th>ToDo Cloud</th>
<th>Wunderlist</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
</tr>
</tbody>
</table>
**THE WINNER** **OmniFocus 2**

Style, substance and a few tricks up its productive sleeve

Choosing a winner is hard because the apps are very different in what they do. Clear excels at making lists, but does nothing else. Conversely, Things makes an excellent job of putting the Getting Things Done methodology into practice. If you want to collaborate with others, though, you'll need to choose either ToDo or the Pro version of Wunderlist, both of which also have web browser versions. Meanwhile, we loved TaskPaper's no-frills text and keyboard shortcut approach, but its lack of an iOS version makes it less useful for adding and updating tasks on the go.

OmniFocus is almost in a category of its own. Yes, it uses GTD ideas and conventions, but there's so much more to it than that. Take the time to investigate the myriad different ways of viewing and organising tasks and you'll find it to be a hugely impressive tool for managing everything from day-to-day tasks to large projects. That, plus the availability of an iOS and even a Watch version so you can work on the go, makes it our winner.

---

**How do they compare?**

<table>
<thead>
<tr>
<th>THE SPECS</th>
<th>Clear</th>
<th>OmniFocus 2</th>
<th>TaskPaper</th>
<th>Things</th>
<th>ToDo Cloud</th>
<th>Wunderlist</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEVELOPER</td>
<td>Realmac Software</td>
<td>Omni Group</td>
<td>Jesse Grosjean</td>
<td>Cultured Code</td>
<td>Appigo</td>
<td>Wunderlist</td>
</tr>
<tr>
<td>URL</td>
<td>realmacsoftware.com</td>
<td>omnigroup.com</td>
<td>taskpaper.com</td>
<td>culturedcode.com</td>
<td>appigo.com</td>
<td>wunderlist.com</td>
</tr>
<tr>
<td>iOS APP?</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>WATCH APP?</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>MULTI-USER?</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>In Pro version</td>
</tr>
<tr>
<td>ACCESSIBLE IN WEB BROWSER?</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>NOTIFICATION CENTER SUPPORT?</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CALENDAR/REMINDERS INTEGRATION?</td>
<td>No</td>
<td>Yes*</td>
<td>No</td>
<td>Yes**</td>
<td>No</td>
<td>Yes***</td>
</tr>
<tr>
<td>INTERFACE</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
</tr>
<tr>
<td>LEARNING CURVE</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
</tr>
<tr>
<td>SYNCING</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
</tr>
<tr>
<td>QUICK ENTRY</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
<td>★★★★</td>
</tr>
<tr>
<td>FINAL VERDICT</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
<td>★★★★★</td>
</tr>
</tbody>
</table>

* Can view appointments in forecast view  **Can show Reminders in inbox  ***Can feed Wunderlist tasks to Calendar

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.

---

Graham says...

» Editing a magazine means I've always got several jobs on at once, so getting things under control is a must. It may take a bit of getting used to, but OmniFocus does a bit of everything, and does it well. With that in my arsenal, I may finally be able to clear my in-tray and find time to learn the guitar (and perhaps serenade my colleagues, too).
Pastebot
Infinite clipboards for your Mac

The Mac’s Clipboard hasn’t evolved past the bare basics of copy and paste. Old hands may argue the Mac’s even gone backwards – once, Scrapbook enabled you to store several items to paste elsewhere. Now Pastebot has arrived – a ‘super Scrapbook’ for the modern Mac.

At its most basic, Pastebot is a huge clipboard, holding up to 1,000 clippings. You can ignore copies over a certain size, sync clippings over iCloud, and easily get at them using a Quick Paste window invoked by using `⌘`+`⌘`+`v`.

The most recent 10 copies can be pasted using number keys; or you can navigate with the arrow keys or the mouse, and navigate through your clippings history using the window’s search field. This proves responsive and reliable, but it’s arguably elsewhere that Pastebot’s real magic happens. The main window lists data for each clip (origin, size, date, and so on), and you can search by these criteria. Favourites can be stored as custom clipping sets, and accessed using shortcuts.

Best of all are the filters, which rework copied text – for example, changing its case or transforming words into an HTML list. Several filters are included, but you can make your own. In the right hands, filters make Pastebot hugely powerful, but even just the basics make it well worth the outlay.

CRAIG GRANNELL

**VERDICT**
A Clipboard utility that will transform the way you copy and paste.

- Usable yet deep
- Filters are superb

Squash 2
The fun way to compress images

Optimising images for the web is not usually fun. Enter Squash 2, which squishes images to make them load faster, all with an ‘oddly satisfying sound’.

Squash is that rare thing: a serious app with a playful personality. It optimises and converts image files so they’re ready to email or upload to websites or social networks. The app performs those jobs exceptionally well, either individually or in batches, and with a satisfying sound, fun animations and nicely chosen language.

Using Squash is simple. Just drag the file or files you want to optimise onto its window and it’ll get to work. It can compress JPEGs and PNGs to make them vastly smaller with no loss of visual quality, and you can adjust the level of compression to make it more or less aggressive in the app’s preferences or the Touch Bar, if your Mac has one. There’s also an option to strip metadata from JPEGs.

Squash can convert files, too: PSD, CR2, TIFF and raw formats magically become JPEGs without having to open (or own) Photoshop, making this a particularly useful app if you’re a designer who often has to send ideas or finished designs to clients. Fast, easy to use, and with impressive results, Squash 2 shines a little ray of sunshine on a task that’s normally dull and dreary.

GARY MARSHALL

**VERDICT**
Squash 2 will save you time, speed up web pages, and it’ll make you smile too.

- Fast and funny
- Touch Bar support

£9.99 FROM Tapbots, tapbots.com

NEEDS OS X 10.11 or higher

£14.99 FROM Realmac Software, realmacsoftware.com

NEEDS OS X 10.11 or higher
Running Windows apps or games on your Mac can be hard work, but CrossOver offers an elegant, affordable solution. You don’t need to buy a copy of Windows, and you don’t need the hassle of setting up Bootcamp or a full-blown virtual machine just to run one program.

CrossOver is based on the open-source Wine project. You basically install Windows programs into self-contained “bottles”, which run a skeletal version of Windows – from 98 up to Windows 10. These contain the bare minimum required to run the program in question – there’s no underlying desktop environment, for example; instead bottles can simply be accessed and run direct from your Mac desktop as if they were native apps.

The downside is that CrossOver isn’t guaranteed to work with all programs – and even those that are supported can be buggy, crashing when you try specific tasks or not behaving as you’d expect. This is why trying the 14-day trial before purchase is essential. If it’s a commercial title, you’ll probably need to provide the original installer disc (Remote Disc works well if required). If an app isn’t listed, that doesn’t mean it won’t work; many haven’t yet been tested, while others require a bit of work (although they may not work that well).

You can create your own bottles from scratch, add required pre-requisites (such as the .NET Framework) and then attempt to install apps yourself. You can tweak your bottles too, to try to improve performance, boost compatibility or simply integrate it better into your Mac desktop.

Beyond the basics
This version updates CrossOver’s underlying engine to Wine 2.0, and introduces support for Office 2013 and 64-bit bottles – the latter should boost performance and compatibility of the app going forward.

CrossOver has always sold itself as a more user-friendly front end for Wine and changes introduced in version 15 mean it succeeds admirably: a redesigned assistant makes verifying and installing any of the 13,000 compatible programs in its database as easy as possible, and there’s also a much-improved bottle management page for viewing, launching and editing your Windows apps.

CrossOver will ultimately be judged on its results, and we find it the most elegant solution for integrating old Windows apps and games into your Mac (providing you can get them working). We recommend you pay a bit extra for the £38 package, which comes with one year’s free updates and support, in which time more Windows apps should become compatible. At this price, it’s a steal.

CrossOver has always sold itself as a more user-friendly front end for Wine.
**Exacto**
A photo editing app that’s a cut above the rest

Cutting out an image on your iPhone is never easy. Apps have to balance ease of use with accuracy; Exacto’s solution is a tool not unlike Photoshop’s pen tool.

Tap to add blue dots (your anchor points), then tweak your lines into curves with the black dots added between your anchor points.

This proves to be an accurate, if time consuming, method. It’s worth it though. Each point’s position can be adjusted, aided by a useful two-finger zoom function, to ensure close accuracy. Tap and hold to move a point and it temporarily disappears, creating an unobstructed view of your cutout and making point editing easier.

Once you’ve finished creating your selection, you can add another layer to add a secondary selection. This is particularly useful if you’ve cut around a circular object and need to cut out a hole in the middle, for instance.

Exacto crashed once in our testing, but that was on a very detailed image with a large number of dots. It’s also a little fiddly, but that's the price you pay for accuracy.

** VERDICT **
Precise cutouts
Occasional crashes

While you’ll probably reserve this sort of work for your Mac, if you need to cut something out on iOS with a high degree of precision, Exacto should be your first port of call. ALEX BLAKE

** djay Pro **
DJ rigs go micro but mighty

It’s get this out of the way first: yes, you feel a bit silly DJing on an iPhone. But if you possess fingers that are small enough, they can do astonishing things in this app – and if you have an iPhone 7 or iPhone 7 Plus, those astonishing things can include mixing 4K video and outputting in full HD.

Algoriddim’s quest to get djay Pro to work on ever-smaller devices means that you can now get almost all of the djay Pro experience on your iPhone. You can choose between jog wheels, four decks, waveforms, sampler or video, pull in songs from Spotify as well as from your library, control visual effects and send visuals to external displays via cable or AirPlay. If you have the iPhone 7 or 7 Plus you’ll also get haptic feedback from the app – this makes things even more fun.

All the important stuff makes it over to the iPhone. BPM and beat detection, key detection, auto-gain and normalisation, live sampling and video mixing are all present and correct. You might feel a bit daft DJing on your phone instead of a full set of decks, but the app is more than up to the job.

djay Pro on iPhone is one of those gee-whiz apps where you can’t quite believe that you’re doing what you’re doing on your phone. But we’ve kept the best bit to last: you can even DJ from the diddy face of your Apple Watch. GARY MARSHALL

** VERDICT **
Mix up to 4 sources
Great, intuitive tools

You get some great noises to use when asked if you have any Spandau Ballet.
Notion Email Intelligence
Filter your email automatically

Reviewed by KATE GRAY

With just one swipe you can archive, flag, and mark emails as read

Email is a pain in the apps; it’s hard to find something that suits your specifications – whatever you use it for, it always feels like the app is optimised for someone else. Notion Email Intelligence works pretty damn well, especially for something that’s free.

The main draw of the app is that it uses artificial intelligence to figure out who and what is important to you. It’s not entirely obvious how it does it, but after 25 to 60 minutes of thinking about it when you first set up the app, it does pretty well. It’s a little creepy having a list of ‘people that are the most important to you’, especially if it’s a business email account and it starts rating your clients as 10/10 in terms of closeness, but we can forgive that. It works, after all.

With just one swipe you can archive, flag, and mark emails as read. Once you get used to which direction does what, it makes going through emails an absolute breeze. There’s a Radar tab, too, which is absolutely fantastic (as long as it works) – it picks up on questions within your emails and flags them up for you, telling you to respond ASAP, and monitoring other people’s delayed responses. It even prompts you to respond to new questions within a certain time, presumably to get better at using email!

A novel email notion
Notion has some issues, mostly to do with its simplicity. It’s hard to figure out how to tell the app who is important to you if it already decided that someone isn’t. ‘Unimportant’ emails are grey, and can be archived in bulk, but if there are important emails among them you might accidentally archive those as well. You can also filter by which emails are starred, but not by unread. There are options like ‘Insight Signature’, which offers to add relevant statistics to ‘encourage responses’, but that’s all terrifyingly vague.

All in all, Notion Email Intelligence, despite being somewhat obfuscated by its minimal design philosophy, is an excellent way to manage your email. You might want to pair it with another email app to ensure nothing slips through the cracks, though, which seems a bit clunky.
Welcome to MacFormat’s Store Guide, the place to go to find out about all the Apple kit that matters, whether you’re looking for your next iPhone or a powerful new desktop Mac. We’ve chosen our top products from Apple’s product line-up, plus the best third-party kit that meets our quality standard.

Whether you’re a recent convert or a seasoned Apple user, we highlight a model of each product that’s ideally suited to your needs. So, check our handy tables to see which Mac, iPad or iPhone is best for you. We’ve also highlighted the gold standard in audio, storage, cameras, and many other categories to complement your Mac or iOS device with the best accessories.

Who’s it for?

**ENTRY LEVEL**
> You’re just getting started in the world of Apple and need to know where to begin.

**UPGRADER**
> A firm Apple user, you’re ready to move on and get even more from your tech.

**HIGH END**
> Apple is your life. You prize quality and want the best that money can buy.

Inside your buying guide...

### iMac

> Ever since the famous Bondi Blue iMac debuted way back in August 1998, Apple’s all-in-one desktop computer has been setting standards in gorgeous design and powerful performance. Apple’s spirit of innovation was as clear back then as it is today - the iMac was the first Macintosh to abandon the floppy disk in favour of USB ports, and its bright, colourful aesthetic set it apart as a playful pretender in a world of staid beige boxes.

These days Apple is again pushing boundaries with the iMac, blessing all of its 27-inch models with the world’s best display, which has a massive 5K (5120x2880) resolution and a wider colour gamut than previous models. Add in a quad-core Intel Core i5 processor (configurable from 3.2GHz up to 4.0GHz), 8GB of memory, a fast and capacious Fusion Drive, and a powerful AMD Radeon R9 graphics processor – and the large iMac is the desktop system to own. In 2015, Apple introduced the first 21.5-inch iMac with a Retina 4K (4096x2304) display. All except the entry-level, 21.5-inch model have a quad-core processor.

<table>
<thead>
<tr>
<th>Model</th>
<th>Key Specifications</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>21.5-inch</td>
<td>MEMORY 8GB of 1867MHz LPDDR3</td>
<td>£1,249</td>
</tr>
<tr>
<td>2.8GHz</td>
<td>GRAPHICS Intel Iris Pro Graphics 6200</td>
<td></td>
</tr>
<tr>
<td></td>
<td>STORAGE 1TB (5,400rpm) hard drive DISPLAY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1920x1080 (IPS, sRGB gamut) ALSO Magic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mouse 2, Magic Keyboard</td>
<td></td>
</tr>
<tr>
<td>21.5-inch</td>
<td>MEMORY 8GB of 1867MHz LPDDR3</td>
<td>£1,449</td>
</tr>
<tr>
<td>3.1GHz</td>
<td>GRAPHICS Intel Iris Pro Graphics 6200</td>
<td></td>
</tr>
<tr>
<td></td>
<td>STORAGE 1TB (5,400rpm) hard drive DISPLAY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Retina 4K (IPS, P3 gamut) ALSO Magic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mouse 2, Magic Keyboard</td>
<td></td>
</tr>
<tr>
<td>27-inch</td>
<td>MEMORY 8GB of 1867MHz DDR3</td>
<td>£2,249</td>
</tr>
<tr>
<td>3.3GHz</td>
<td>GRAPHICS AMD Radeon R9 M395</td>
<td></td>
</tr>
<tr>
<td></td>
<td>STORAGE 2TB Fusion Drive DISPLAY Retina 5K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(IPS, P3 gamut) ALSO Magic Mouse 2, Magic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Keyboard</td>
<td></td>
</tr>
</tbody>
</table>

---

macformat.com | @macformat

104 | MACFORMAT | APRIL 2017
The baby of Apple’s laptop family, the MacBook was updated in early 2016 with slightly improved specs and a new Rose Gold colour. Weighing in at just 0.92kg, it’s Apple’s most lightweight laptop but still packs in a 226ppi pixel density in its 12-inch Retina display.

The MacBook is powered by an Intel Core M processor (at 1.1GHz, 1.2GHz or 1.3GHz), which doesn’t require a fan to keep cool, so the MacBook runs silently. It also features a Force Touch trackpad, which can trigger different responses as you apply more pressure. All models of the MacBook come with 8GB of 1866MHz memory, with no option to add more, and Intel HD Graphics 515 – that’s 25% faster than the previous iteration – and there are 256GB or 512GB flash storage options. There are four colour options: Silver, Space Grey, Gold, and the new Rose Gold.

MacBook

Choose a MacBook

<table>
<thead>
<tr>
<th>MODEL</th>
<th>KEY SPECIFICATIONS</th>
<th>PRICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>12-inch 1.1GHz dual-core Intel Core m3</td>
<td>MEMORY 8GB of 1866MHz LPDDR3 Graphics Intel HD Graphics 515 STORAGE 256GB SSD</td>
<td>£1,249</td>
</tr>
<tr>
<td>12-inch 1.2GHz dual-core Intel Core m5</td>
<td>MEMORY 8GB of 1866MHz LPDDR3 Graphics Intel HD Graphics 515 STORAGE 512GB SSD</td>
<td>£1,549</td>
</tr>
<tr>
<td>12-inch 1.3GHz dual-core Intel Core m7</td>
<td>MEMORY 8GB of 1866MHz LPDDR3 Graphics Intel HD Graphics 515 STORAGE 512GB SSD</td>
<td>£1,684</td>
</tr>
</tbody>
</table>

MacBook Pro

Choose a MacBook Pro

<table>
<thead>
<tr>
<th>MODEL</th>
<th>KEY SPECIFICATIONS</th>
<th>PRICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>13-inch 2.0GHz dual-core Intel Core i5</td>
<td>MEMORY 8GB of 1866MHz LPDDR3 GPU Intel Iris 5400 STORAGE 256GB SSD Touch Bar No</td>
<td>£1,449</td>
</tr>
<tr>
<td>13-inch 2.9GHz quad-core Intel Core i5</td>
<td>MEMORY 8GB of 2133MHz LPDDR3 GPU Intel Iris 5500 STORAGE 256GB SSD Touch Bar Yes</td>
<td>£1,749</td>
</tr>
<tr>
<td>15-inch 2.6GHz quad-core Intel Core i7</td>
<td>MEMORY 16GB of 2133MHz LPDDR3 GPU Radeon Pro 450 STORAGE 256GB SSD Touch Bar Yes</td>
<td>£2,349</td>
</tr>
</tbody>
</table>

Mac Pro

If you need power – and we mean serious power – this is the computer for you. Even the entry-level model comes with 12GB of memory, a quad-core 3.7GHz processor, 256GB of speedy PCIe flash storage and dual AMD FirePro D300 graphics cards. However, with a high cost, last being updated in 2013, and Thunderbolt 3 debuting in the new MacBook Pro, it’s worth holding out for the next version.

Mac mini

A welcome update in 2014 brought a £100 price drop to the most affordable Mac, but rises in late 2016 added £80 back on. The mini has some interesting talking points: the entry-level model has a 1.4GHz dual-core Intel Core i5 processor and 4GB of memory, making it one of the lowest-spec Macs around, with a 500GB hard drive and no display. Higher end models come with 1TB storage (Fusion Drive and SSD options are available), 8GB of memory, a better graphics processor and either a 2.6GHz or 2.8GHz Intel Core i5 for £679 and £949. Those models can be upgraded to a Core i7, but there aren’t any quad-core options available.

macformat.com @macformat
The iPhone 7 represents a big update, no doubt about it. Apple introduced an amazing dual-camera setup in the Plus model, which allows for 2x optical zoom and on-the-fly depth-of-field effects.

Both sizes feature the improved A10 Fusion chip, a redesigned Home button with haptic feedback, better battery life, Lightning EarPods, and storage ranging from 32GB to 256GB.

The iPhone 6s and 6s Plus are still available, and are great devices in their own right. With 3D Touch giving you a greater range of interactions with apps, plus a 12MP rear camera with 4K video recording and Live Photos, consider them if the iPhone 7 is too expensive.

And let’s not forget the iPhone SE. Though it lacks 3D Touch, it packs in many of the 6s’s features, such as the A9 chip and M9 motion coprocessor, and has a more compact 4-inch screen.

**Choose an iPhone**

<table>
<thead>
<tr>
<th>Model</th>
<th>Key Specifications</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPhone SE (4-inch display)</td>
<td>CAPACITY: 64GB, PROCESSOR: A9, 3D TOUCH No, CAMERA 12MP photos, 4K video recording</td>
<td>£429</td>
</tr>
<tr>
<td>iPhone 6s (4.7-inch display)</td>
<td>CAPACITY: 128GB, PROCESSOR: A9, 3D TOUCH Yes, CAMERA 12MP photos, 4K video recording</td>
<td>£599</td>
</tr>
<tr>
<td>iPhone 7 Plus (5.5-inch display)</td>
<td>CAPACITY: 128GB, PROCESSOR: A10 Fusion, 3D TOUCH Yes, CAMERA 12MP photos (dual-camera), 4K video</td>
<td>£819</td>
</tr>
</tbody>
</table>

**iPad**

Apple didn’t change much in the way of its iPad range during its September event, but it did tweak its iPad storage options and prices. The iPad Air 2 and iPad mini 4 and iPad mini 2 now start at 32GB instead of 16GB – rejoice!

But it wasn’t all good news. Thanks to currency fluctuations post-Brexit, Apple has raised iPad prices (despite lowering them in the US).

On the software side, the iPad adds multitasking features, which are a boon for productivity. You can slide a second app over the right side of the one you’re working in, then dismiss it to get back to work. Picture in Picture enables you to watch video in a corner of the screen. Those two features work on the Air 2, mini 2 and Pro and newer models. There’s also Split View, on the Air 2, mini 4 and Pro, which lets you work on two apps side by side.

**Choose an iPad**

<table>
<thead>
<tr>
<th>Model</th>
<th>Key Specifications</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPad mini 4</td>
<td>CAPACITY 32GB, PROCESSOR A8, CONNECTIVITY Wi-Fi, CAMERA 8MP, TOUCH ID Yes</td>
<td>£379</td>
</tr>
<tr>
<td>iPad Air 2</td>
<td>CAPACITY 128GB, PROCESSOR A8X, CONNECTIVITY Wi-Fi, CAMERA 8MP, TOUCH ID Yes</td>
<td>£469</td>
</tr>
<tr>
<td>12.9-inch iPad Pro</td>
<td>CAPACITY 128GB, PROCESSOR A9X, CONNECTIVITY Wi-Fi, CAMERA 8MP, TOUCH ID Yes</td>
<td>£819</td>
</tr>
</tbody>
</table>

**iPad Pro**

The iPad Pro comes in 9.7-inch and 12.9-inch sizes, packed with either 32GB, 128GB or 256GB of storage. All models except the 32GB, 12.9-inch one are available with the option of mobile network connectivity. The Pro’s A9X chip is the most powerful in any iOS device, and it has an impressive four-speaker sound system, too. Adding the pressure-sensitive Apple Pencil makes it an accomplished drawing tool.

**Watch**

The Watch has already made Apple the second biggest watchmaker in the world. Apple is continuing this push with Apple Watch Series 2, which sees a big update to the Watch. It’s water-resistant to 50 metres so you can take it for a swim, it has a faster dual-core processor and GPU, and a brighter display. There’s also built-in GPS, which can measure routes, pace and distance when you’re out on a run or hike without needing an iPhone.

Apple also introduced a ceramic model to replace the gold Edition, and has partnered with Nike to create the Apple Watch Nike+, a range of runner-oriented models. The Hermès straps come in new colours and designs, too.
BEST BUYS… curated picks of third-party kit

**Monitor**
ViewSonic VP2772
£650
viewsonic.com

If you’re not fussed about 4K but still want exceptional image quality, this IPS display is truly superb. It offers 99% coverage of the Adobe RGB colour space, 10-bit colour and a 2560x1440-pixel resolution. It has HDMI 1.4, DVI and Mini DisplayPort connections, and four USB 3.0 ports for expansion.

**Ultra HD Monitor**
Philips 328P6VJEB
£573
philips.co.uk

We love this display. At 32 inches diagonally it’s big enough to make its 4K resolution worthwhile, and its colour rendering is excellent – 100% of sRGB, 93% of Adobe RGB and 97% of the P3 gamut that Apple’s new MacBook Pro uses. It’s big, bold, beautiful and superb for productivity and colour work alike.

**Network Storage**
QNAP TS-251+ 6TB
£480
qnap.com

We know a good NAS drive when we see one, which is why the 6TB TS-251+ won MF302’s group test. It’s one of the quickest NAS drives we’ve seen lately, with transfer rates of over 105MB/sec for large files. It has an HDMI port and a remote control for watching your media directly on your TV set. Four USB ports top it off.

**Wireless Router**
D-Link AC3200 (DIR-890L)
£209
dlink.com

Being a tri-band router, this blows every other router we’ve seen out of the water when it comes to speed. We saw speeds of 600Mbps between two Macs in the same room. Wi-Fi speeds hit up to 3.2Gbps, so its three channels mean it’s no slouch there either. It’s costly, but is a worthy investment if speed is your thing.

**Thunderbolt Dock**
CalDigit Thunderbolt Station 2
£210
caldigit.com/uk

Our MF297 group test winner got the nod for its beautifully compact form and superb menu bar tool, which lets you eject individual drives as you please (something its rivals failed to offer). It’s not the most laden with ports, but has everything that most people will need, and comes in at a great price point.

**Printer**
Brother HL-3150CDW
£108
brother.co.uk

This versatile laser printer got the nod in MF300’s group test. Its light design, feature list, and impressive print quality make it a great choice for home office users. AirPrint and Wi-Fi connectivity means it plays nice with your iOS devices. It’s not great for printing photos, but is a winner at everything else.

**IP Camera**
Logi Circle
£130
logitech.com

Winner of MF299’s group test, the Logi Circle is packed with features. It’s so easy to use and can be powered by batteries, making it highly portable. With a wide 135° field of vision, it captures plenty of detail, and is very affordable. The Logi Circle is a barnstorming all-rounder, and looks great on your mantlepiece.

**External SSD**
G-Technology G-Drive Slim SSD USB-C
£157
g-technology.co.uk

Most USB SSDs we’ve tested have peaked at about 440MB/sec, but not this 500GB one; it peaked at 496.1MB/sec for write speeds and 534.7MB/sec when reading, very close to the claimed 540MB/sec. It lagged a bit in our random read test, but for copying big files over USB-C, this is the drive to pick.

**Macbook Bag**
Knomo Hanson
£90
knomobags.com

Deceptively spacious inside, the Hanson is full of well-padded pockets to protect your precious portables. It’s extremely comfortable, distributing weight well so your shoulders don’t feel the strain, and is rather good looking, but remains subtle enough not to attract the attention of light-fingered thieves.
**PORTABLE BATTERY PACK**

Apple iPhone 7 Smart Battery Case £89
apple.com/uk

Despite that silly-looking hump on its back, the official battery case for the iPhone 7 is rather impressive. It’s easy to fit, the buttons feel great, and the soft inner lining protects against scratches. It isn’t the largest capacity case, yet it has more than enough juice for busy days, and the bump is surprisingly comfy.

**MICROPHONE**

Blue Microphones Raspberry £204
bluemic.com

Don’t be fooled by this mic’s small form factor; it punches hugely above its weight. Its close-up sound is intimate and bassy, and brings out the best in any voice. No matter whether you’re recording an interview, creating a podcast or just jamming with your band, its clarity and depth makes it easy to recommend.

**BLUETOOTH TRACKER**

Tile Slim From £23
thetileapp.com

The little tracking device that won us over in issue 299 has been made even smaller with the new Slim model. It’s now far more portable than before, and easily slips into your wallet as it’s about as thick as two credit cards. With a great app and a loud alarm, your valuables will be kept safer than ever with this little beauty.

**ON-EAR HEADPHONES**

Sennheiser PXC 550 Wireless £330
sennheiser.com

We love these wireless cans. They’re comfortable and lightweight, and their long-lasting battery keeps them going for 22 hours. Sound quality is amazing: wide, rich and detailed, with plenty of bass, too. The controls take some getting used to, but active noise cancellation is superb and the EQ allows plenty of customisation.

**NEW! ACTION CAMERA**

GoPro Hero5 Black £349
gopro.com

We looked at GoPro’s new flagship action cam this issue, and it coloured us impressed. GoPro has finally improved its cam’s usability, and its a cinch to get started with the Hero5 Black. Add in top-notch 4K video quality plus a great range of shooting options and you’ve got a hugely powerful camera on your hands.

**FITNESS SMARTWATCH**

Garmin Vivoactive HR £184
garmin.com

Packed full of tracking features for a host of sports, and filled with genuinely insightful metrics, this is a fitness smartwatch for nearly any occasion. Its battery will last you days, perfect for the odd weekend hiking trip. With all this, it’s not hard to see why it won MF308’s group test.

**WIRELESS SPEAKER**

Bowers & Wilkins Zeppelin Wireless £499
bowers-wilkins.co.uk

This airship-inspired speaker is certainly striking, but it’s more than just a looker, with crisp, clear treble and refined bass output over previous Zeppelin models. Support for Bluetooth, Spotify Connect and AirPlay makes for plenty of connectivity, and dynamic EQ ensures controlled bass at all volumes.

**PORTABLE SPEAKER**

Libratone Zipp £144
libratone.com

Want a multiroom audio system in your home? This is your best option, hands down. It cleaned up in MF309’s group test, scoring five stars in every test category. From top-notch sound to tons of great features, the Zipp is a superb choice. It even boasts AirPlay for great integration with Macs and iOS devices.

**IN-EAR HEADPHONES**

Optoma NuForce BE Sport3 £80
optoma.co.uk

These in-ear buds prove that the wireless future is a bright one. They feel reassuringly solid and fit remarkably well, even when you’re out on a run or in the gym. They’re IP55-rated for dust, sweat and rain resistance and have great battery life, balanced sound and incredible noise isolation. Great, affordable buds.

**IN-EAR HEADPHONES**

Optoma NuForce BE Sport3 £80
optoma.co.uk
Recycle your magazine and seven days later it could come back as your newspaper.

www.recyclenow.com

Mac Spares & Repairs
- New & recycled parts for your Mac, iPad and iPhone
- Next day UPS delivery
- Trade discounts
- Refurbished Macs with 3 month warranty
- Repair service, uk-wide collection

thebookyard
thebookyard.com 08456 800 256

mac2cash.com
Turn your Mac to cash in 48 hours!

Quote Collect Inspect Pay
Just enter your serial number for an instant quote...

Fast Simple Safe
We buy working and faulty Macs, iPads & iPhones. Free collection.

Brought to you by thebookyard

Slash your internet, TV & phone bills!

Save up to £408* per year

One quick call.
Thousands of deals.

LOWEST PRICE GUARANTEE

We do the hard work for you:
1. Call free and speak to our London based impartial experts.
2. We review over 6,000 deals from the top UK providers to find the right one for you - with our Lowest Price Guarantee.
3. Our experts do the hard work, answer your questions and even arrange your installation!

We’re proud to be the only service to be accredited by Ofcom for TV, broadband and home phone comparison

Call us free and we’ll do the hard work!
0800 466 1053

www.techradarstores.co.uk/digitalsave Or text “DEAL” to 81400 and we’ll call you

*Simplifydigital customers received an average saving of £408. Data based on 1,538 records between 1st of Jan 2019 and 8th Nov 2019. **Out of 445 consultations between 01/01/2019 and 03/05/2019, 348 Simplifydigital customers saved money by signing up to our recommended deal. Lowest Price Guarantee Terms and Conditions apply - see www.simplifydigital.co.uk/lowest-price-guarantee for full details. Standard SMS network charges apply.
We are committed to only using magazine paper which is derived from well managed, certified forestry and chlorine-free manufacture. Future Publishing and its paper suppliers have been independently certified in accordance with the rules of the FSC (Forest Stewardship Council).
Monastic Moment

BY SHAUNG22

EQUIPMENT iPhone 7

@shaung22 captured this warm-tone moment of a Buddhist monk reflecting on his journey - on an untold number of levels, no doubt.

According to Instagram, @shaung22 likes to use his iPhone 7 and the FujiFilm X-Pro 2 to take shots while travelling and stopping off for the odd cold beer. Thanks for sharing the shot!

Share your pics with us using the hashtag #MacFormat on Instagram. In each issue we’ll pick our favourites to feature on this page.

WHAT TO DO!

1. Open an Instagram account.
2. Follow @MacFormatUK (of course).
3. Take a picture of, or with, your Apple kit.
4. Share it on Instagram or Twitter.
5. Use the hashtag #MacFormat.
6. Feel the warm glow of an appreciative Apple community.
7. See if you made it onto the pages of this very magazine!
8. Repeat.
Do I need Antivirus?

Is it a good idea to buy or use antivirus software? Is it necessary with a Mac? I have an ageing 17” MacBook Pro with top bespoke spec for NLEditing (FCP or Avid). Recently I’ve been getting unsolicited pages coming up on Safari, but also a page from MacKeeper telling me I have over 2,000 viruses that need cleaning (if I pay for their licence). Is the antivirus software itself the cause of the problem? Perhaps it could have been downloaded accidentally, because I seem to have its basic free program installed with my applications? Or is such software good and I might well have viruses that need attending to and if so what antivirus software would you recommend and is it expensive? Otherwise how do I remove MacKeeper?

By John Veal

Graham Says... Our general advice on MacFormat is to only get apps that promise to remove viruses from a reputable source. Quite often you’ll find that a free program will do the job for you perfectly well, if you actually do have malware on your Mac. If you search for information about MacKeeper on Google, you’ll find all sorts of warnings about this program, and also guides to uninstalling it. I’d say it’s very unlikely that your Mac has a single piece of malware on it, let alone 2,000 of them. In terms of whether your Mac actually needs antivirus software at all, check out our feature on page 14, where we address this problematic issue. The main risk of a virus on your Mac is that you’ve received it unwittingly in an email, and you pass it onto a Windows-using colleague where it can actually do some damage. Or you may have Windows installed on your own Mac with Boot Camp, where it could inflict damage. So, if you want to be a good citizen then you probably should have some form of antivirus software, however, if you just use common sense, and don’t visit dodgy-looking websites then the chances of you getting something nasty on your Mac are extremely slim.

Win a Creative NUNO

Starting this issue, the author of our Star Letter will receive a prize! This month it’s the Creative NUNO, a portable, wireless speaker with high-performance speakers under its cloth covering. Find out more at: http://uk.creative.com

Letter of the Month!

The Genius Handbook

At last, some practical, on-going common sense to unearth Apple’s hidden information — just what the average Mac user has wanted for ever to make some sense of the quagmire of confusion surrounding life with a Mac — no matter which particular piece(s) of kit one owns (not to mention the drama of ‘updates’ that change things without warning).

Carry on the good work!

By Colin Stevens

Alan Says... We’re glad you liked the issue Colin, although we like to think that life with a Mac is surprisingly drama-free compared to life with a Windows PC! Apple does like to keep sending us huge updates to install all the time, but on the whole things could be a lot worse. If anybody missed last issue then see the Back Issues offers on page 76 for details on how to get your own copy of The Genius Handbook.

A Cautionary Tale

Yesterday, the 14th of February, I decided to use FileVault on my late 2013 iMac. It has the standard 1TB internal drive and a 1TB external as for Time Machine back ups. The main drive has only 177.46 GB of files on it, mostly Spanish and German language lessons. Once I triggered the use of FileVault, I found that it would take an estimated two days to complete the encryption. As I write...
**MONITOR CONFUSION**

In last month’s issue (MF310), when reviewing 4K monitor displays, on page 97 a Philips 40” set priced £589 is featured. Over the page, the Group Test features a 27” Philips, costing £637. Turning to the ‘Best Buys’ page, a Philips 32” ultra monitor is recommended, costing £573. Other than size, if there is a significant difference in performance between these three monitors, should that not be mentioned? Otherwise why would anyone buy a 27” Philips when they can buy a 5” larger set for around £60 less?

**BY MIKE ARNOLD**

**ALEX SAYS...** There are a few reasons why one would choose the 27” Philips display over the 40” Philips option, despite it costing more. We mistakenly noted that the larger monitor was an IPS panel in the magazine - in fact, the 40” monitor has a VA panel, while the 27” display is an IPS panel. As you will have seen from the picture quality test, a VA panel is at a disadvantage compared to an IPS panel due to its inferior colour reproduction and viewing angles. The issue of size is also important - a 40” monitor is pushing the upper limit of usable size for most people, whereas a 27” display is much more manageable.

We deliberately chose to include monitors sized between 27- and 32-inches in the group test because we felt that was a good size for home use. Finally, the Philips display in the Store Guide has stuck it out mainly because of its fantastic colour rendering. It’s also worth noting that prices fluctuate, often wildly, between the point when we order in units to review and the date we send the pages to the printer.

---

**What do you think?**

**WHICH NEW PIECE OF APPLE KIT DO YOU WANT IN 2017**

This issue the team speculated about what new products Apple has in store for us this year. But we want your opinion too! Which new products would you like to see Apple release next? Let us know by email and you could be featured in next issue’s Contacts page! Missed it? Turn to p82

---

Love your Mac? Then don’t turn on File Vault unless you really need it.

Last week, 24 hours on, it is saying “more than one day’s work remaining”. This alternates between 10 hours and one day! The real problem is that after internet searches and two calls to Apple, I now find that the process cannot be stopped and must run its course before I can turn the feature off. To make matters worse, if the machine decides to close down, as mine did last night, it’s possible to experience great difficulty trying to restart it. Thanks to MacFormat’s tips I was able to get it up and running, or at least so it appeared, and I was able to turn off the FileVault encryption. Sadly, though, that is not actually the case as, when I checked in Preferences later, FileVault was back up and running and, guess what, yes at least two days remaining. I have been locked out of the machine twice and had misleading information sent to me, in that the system said that a special unlocking key had been sent to me. To date nothing has appeared on my iPad, iPhone or the Mac itself. All this is stressful and could have been avoided had Apple put even a small warning in the setup procedure that it could take a long time and could not be cancelled until all encryption had finished.

On the plus side, I can still access all my files but if I do I suspect I am slowing it down even further. This is my only effort at work in two days. If I am unheard of again, I may be the late, desiccated skeleton next to the late 2013 Mac...

**BY DAVID SIMPSON**

**GRAHAM SAYS...** We feel your pain David, and we can only hope that by the time you read this, FileVault has actually finished. You’re correct, there’s nothing you can do to speed it up. You just need to wait for it to finish. The real question though is why you wanted to do this, as FileVault is overkill for most Mac users? And, we know you love your Mac, but surely there must be better things to do on Valentine’s Day?
At its launch in 1998, the iMac instantly became a classic. Nothing had looked like it before, and it is even credited with turning around the fortunes of the company. Here we take a look at the history of one of Apple’s best-loved Macs.

The translucent iMac G3 was launched to huge acclaim. “It looks like it’s from another planet,” said then Apple CEO, Steve Jobs.

Welcome to the Internet
The appeal of the original iMac was that it provided you with a quick and easy route to the Internet. It was designed to be ‘Internet ready’ out of the box, with a 56k V.90 modem built into the case. The second generation iMac in 1999 featured the option of AirPort WiFi.

A Mac of many colours
The iMac brought a touch of colour to the previously beige world of home computers. After the initial 1998 Bondi blue model launched, Apple introduced 13 different candy-coloured plastic cases with names like Sage, Indigo and Blue Dalmatian on offer. The colours remained until the 2002 iMac G4 was released.

The iMac helped pave the way for the iPod and iPhone.

A Mac of many colours
The iMac brought a touch of colour to the previously beige world of home computers. After the initial 1998 Bondi blue model launched, Apple introduced 13 different candy-coloured plastic cases with names like Sage, Indigo and Blue Dalmatian on offer. The colours remained until the 2002 iMac G4 was released.

The iMac helped pave the way for the iPod and iPhone.

The iMac designer
The iconic iMac case was designed by Jonathan Ive. Ive became a full time Apple employee in 1992, becoming Senior Vice President of Design in 1997. The iMac was his first design assignment, the first of Apple’s “i” products. It was followed by the iPod, then later the iPhone and the iPad, all of which he worked on.

Next issue on sale
Tuesday 11 April 2017
AKVIS Watercolor

Photo to Art! Watercolor Painting Effect!

akvis.com
As if upgrading isn’t reward enough.

Trade in your Mac and receive up to £391 towards the purchase of your new Mac, including a 3 year guarantee at no extra cost.

Visit Stormfront, your local Apple experts.
Find us at: www.stormfront.co.uk/contact